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Chapter 1: Overview

Welcome to the Fast Start Guide. This book introduces PegaRULES Process
Commander (PRPC) and provides hands-on instructions for modifying an application
built on PRPC. It also introduces terms and skills for application developers.

The hands-on tasks involve working with a small application called ASupply. The
application allows employees of ASupply to submit purchase order requests using their
Web browser and it automates the process of entering, routing, and approving
purchase orders.

The ASupply application is intentionally incomplete and simplified. Your assignment is
to make changes and enhancements to it. The tasks presented in this book show you
how to extend the application by adding and modifying rules to meet the needs of
ASupply. By following these exercises, you will learn to:

» Navigate within the Designer Studio.
» Change the rules to reflect new steps in a business process.
» Create rules that enhance the application user interface and behavior.

» Produce a Microsoft Word document that describes the application and lists its files,
functions, and features.

You make the modifications on your PRPC system in a RuleSet designated for
development. This book takes you step-by-step through each modification.

Business Process Management

According to the Business Process Management Group (at www.bpmg.org), Business
Process Management (BPM) is the organizational activity "that incorporates: Planning,
Designing, Building, Operating, Maintaining, and Improving the business processes
and their enabling capabilities forever and for everyone. Business processes are
capabilities, as important as facilities, people, and technology. Like all assets they
must be managed from inception to retirement.”

PRPC supports Business Process Management through rules for processes,
assignments, routing, decisions, and automated processing. PRPC applications provide
process management and automation through six functional capabilities, informally
known as the Six R's:

» Receiving — Accepting and capturing the essential data describing work from multiple
sources, including keyboards, scanners, and external systems, in a wide range of
media and formats.

» Routing — Using characteristics of the work together with knowledge about the
workforce to make intelligent matches and assignments.

» Reporting — Providing real-time visibility of work in progress, work completed,
productivity, bottlenecks, and quality.
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» Responding — Communicating status, requests for information, and progress to the
work originator and to other people involved in the work, by e-mail, fax, written mail,
and other means.

» Researching — Accessing external systems and databases through connectors to
support analysis and decision-making.

» Resolving — Completing the work and updating downstream systems promptly
through automated processing and automated support of users.

PRPC is the only BPM solution that automates both the business rules and the business
processes that drive work to completion.

Additionally, PRPC employs a sophisticated common object model to deliver the power
of process and practice integration. This integration is achieved without the expense
and resources associated with maintaining separate business process and rules
databases, user interfaces, test environments, and production environments.

Structure of This Document

This book includes the following chapters and appendices:

» Chapter 2 describes how to use the ASupply application.

» Chapter 3 describes how to improve the application by changing the purchase order
request process.

» Chapter 4 describes how to update the user interface.

» Chapter 5 reviews all tasks you completed in the previous chapters.
» Chapter 6 describes how to document your application using PRPC.
» Appendix A provides the ASupply application documentation.

» Appendix B provides a description of the icons and buttons found on the Designer
Studio toolbar and tab bar.

» Appendix C provides additional information that might be useful when setting up your
workstation.

» Appendix D describes how to install the ASupply application.

» Appendix E describes how to contact Pegasystems for education services and
documentation feedback.

Tip: Print Appendix B and have it available as you go through this book to help you learn about

the toolbar and tab bar buttons.
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Knowledgebase and Community

The Pega Developer Network (PDN), located at http:/pdn.pega.com, is the primary
technical resource area for the PRPC community. The PDN contains a broad range of
technical articles including troubleshooting and “how-to” information, as well as a
comprehensive and searchable knowledgebase to help speed application development.

Prerequisites

To follow the steps in the hands-on exercises in this book, you need:

» Access to a PRPC Version 6.2 SP2 system. This specific software version is required
to accommodate the ASupply application that is used in the hands-on exercises. The
installed Pega-ProcessCommander RuleSet version should not be lower than
06-02-20.

Typically, the system administrator for your organization provides access to the
organization’s installed PRPC system. The process for obtaining access is determined
by your organization. Contact your system administrator to obtain the appropriate
access and for assistance in verifying the version of the installed PRPC RuleSet.

» The URL for logging into PRPC. The URL is usually obtained from your organization’s
system administrator. It is typically in the format:
http://<hostname=>:<port>/prweb/PRServlet, where <hostname=> is the
system on which PRPC is installed and <port> is the assigned port. The URL is case
sensitive.

» The ASupply application. To install the application, follow the steps in Appendix D. If
your organization has policies on who can install applications in PRPC, contact your
organization’s system administrator for assistance.

» Intel-based dual-core processor with at least 4GB of free RAM running a 32-bit or 64-
bit version of Microsoft Windows 7 or Vista.

» Microsoft Word 2002 or later (required to produce the Application document).

» Microsoft Internet Explorer (IE) version 7, 8, or 9 with current Microsoft security
patches. All pop-up blockers, such as those provided by Yahoo! or Google toolbars,
must be disabled.

Appendix C describes Internet Explorer settings appropriate for using PRPC.
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Chapter 2: Using the Application

This chapter shows you how to use the application and experience it from the worker
and manager points of view by:

» Creating a purchase order request.

» Approving the purchase order request.

In Chapters 3 and 4, you assume the role of a designer and you change the business
process, appearance, and functions supported by the application.

Creating a Purchase Order

1. Open your browser to the URL for logging into PRPC. The PRPC login screen
appears (Figure 2-1).

Figure 2-1. PRPC Login Screen

The URL is usually obtained from your organization’s system administrator. It is typically in the

format: http://<hostname=>:<port>/prweb/PRServlet, where <hostname=> is the system on

which PRPC is installed and <port> is the assigned port. The URL is case sensitive.

2. Log into the system as WorkUser@ACORP.com with the password password to
access the ASupply application. The Case Worker portal appears (Figure 2-3).
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If prompted with a Windows Security warning, click Install. (Figure 2-2 shows an
example.) This might occur a few more times as Windows downloads each needed
ActiveX control.

Internet Explorer - Security Warning §|

Do you want to install this software?

Mame: PRPC Screen Capture Wersion 5,5,0,15
Publisher: Pegasystems Inc.

[E]More options Install ] [ Don't Install

‘while Files Fram the Internet can be useful, this file tyvpe can potentially harm
wour camputer, Only install software From publishers vou trusk, What's the risk?

Figure 2-2. ActiveX Control Warning

This portal layout, for application users who are not managers, is known as the
Case Worker portal. It provides a standard interface for users to create, view, and
work on their own cases and assignments. The colors, fonts, and logo you see in
this layout are customized for ASupply. PRPC provides defaults. You can build
applications using your company’s standards and formats.

3. Click the E\I>My Worklist tab to view a list of outstanding (not complete)
assignments ready and waiting for the user to perform (ordered by urgency). In
this example, the worklist is empty, displaying the message “No items”.

o
=
-5
Refresh
My Worklist -
Urienl:v;r T ID T Description ~ Goal ¥ Deadline T Status -

Figure 2-3. My Worklist

4. Select Purchase Order from the New selection box (Figure 2-4). A form labeled
Purchase Order appears in the portal header.

Purchase Order I

Figure 2- 4. New Selection Box — Purchase Order
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5. In the Purchase Order form, select IT from the Department Name selection box.
In the Department Number field, type a number. Optionally, type a note in the
Note field (Figure 2-5).

= =) Mews *

et

= P
Ll Purchase Order & Print
Owner i

MName#  Purchase Order O WorkUser @ACORF.com
Details OWNE york User
Mame
Urgency
(1-100)
Effort
(days)
Department T - -
Mame i
Department 3
Number % 2 <
Order Date 3/5/2012 e
Bill Customer [l
3Q supplies needed f—————
Mote

Create —-f————

Figure 2-5. New Purchase Order

6. Click Create at the bottom of the form. This action transmits your input to the
PRPC server and creates a work item according to the purchase order process
defined in this application. The system assigns a sequential identifier called the
work item ID to the work item. This ID is visible in the top bar of the user form
(circled in Figure 2-6). In this application, the work item IDs begin with the prefix
“P-" to identify purchase orders.

a [- ~J
- 0 G
.
M Purchase Order (F-1) | Review [5 Save @ Where AmI € Audit & Print [ Follow © Tags
Case ID P-1 Urgency O w0 Status r"‘ MNew
Created about a minute ago Goal Last Update less than a minute ago
Created by Work User Deadline Last Updated By  Work User
) & 7 &=
Item Mame + Price Quantity * Line Item Total Notes
Select... v $0.00 i § “ |+ Add
n&’ Advanced...
Order Total $0.00
rdertota Mo items

Submit

Figure 2-6. Purchase Order Request P-1
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p-1®

7. Click the Close icon in the work item tab to close it. The E\I>My Worklist
tab displays.

8. On the E\I>My Worklist tab, click Refresh =+ Refresh

The worklist refreshes and an assignment row for this work item appears on your
worklist. Because additional steps are needed before your tasks with the work item
can be completed, a row for this assignment for appears in your worklist. Figure 2-
7 shows a worklist containing one assignment row for the purchase order.

-
Refresh
My Worklist i
Urgency R () T Description T _Goal v Deadline T Status i
@ w P-1 Purchase Order 2 days from now 6 days from now r"‘ MNew

Figure 2-7. Purchase Order in the Worklist

An Urgency value is a number between 0 and 100 that indicates the importance
(priority) of completing and resolving the work assignments. Here, the ASupply
application initially assigns an urgency of 10 to a new assignment. As time passes,
the urgency increases, reflecting the priority of completing the assignment.

Note: You can exit from the ASupply application at any time by clicking the Logoff link in the Work

User selection box, located in the upper left of the portal. Log off before closing the browser window.
Do not use the Internet Explorer Back button when using PRPC. Instead, navigate using the tabs and

buttons within the portal layout.
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Adding Items to Your Purchase Order

1. On your worklist, locate the purchase order you created. Double-click the ID to
reopen the purchase order form for additional processing. The Enter Item
Information section appears in the form (Figure 2-8).

o

LA Purchase Order (P-1) L Review [ 5
Case ID p-1 Urgency O w
Created about a minute ago Goal
Created by Work User Deadline
——
Item Name % Price Quantity Line Item Total
Select... = $0.00 i |

Order Total §0.00

Submit

Figure 2-8. Enter Item Information Section

2. In the Item Name column, select an item from the drop-down list. When an item
is selected, its price appears in the Price column.

3. Click in the Quantity field, enter a number for the quantity to be purchased, and
then press the Tab key. The total charge (price multiplied by quantity) appears for
that line item.

Note: Use the Tab key to advance from field to field. Do not use the Enter key, as pressing Enter

submits the form.
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4. Click the Add a row icon &y to add another row. Select another item and enter its
quantity. If you want, you can add additional rows and more items. Figure 2-9
shows an example.

" » p-1%
—
lJ Purchase Order (F-1) | Review [ Save @ Where AmI € Audit & Print @ Folow $ Tags
Case ID p-1 Urgency @ Status P tew
Created & minutes ago Goal Last Update & minutes ago
Created by Work User Deadline Last Updated By ~ Wark User
S 'm Lt & & o
Item Name # Price Quantity * Line Item Total Notes
Laptop - $1,459.00 2 §2,998.00 i | - + Add
Keyboard v  $50.49 2 $100.98 i | Advanced...
LCD Monitar §359.00 2 §718.00 '}
Printer v 53550 2 §193.00 @) | | Neit=ms
Mouse - £34.00 2 §68.00 o |
Order Total §4,077.98
Submit
Details Additional Information
Mew 0.001 days Open Odays Pending  Odays
Description

Figure 2-9. Purchase Order Line Items

Note: If you make a mistake and want to delete an item’s row, click the garbage can icon at the

right end of the row.

5. Click Submit to move to the next step in the purchase order process (if necessary,
use the right-hand scroll bar to bring the Submit button into view).

6. After clicking Submit, the Confirm Order section appears in the form (note the
Confirm Order label circled in Figure 2-10).
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= = S

sy
@ Purchase Order (F-1) , Review [ Save e: Audit & Print @3 Follow $ Tags

Case ID P-1 Urgency [ LR Status r" Open
Created 11 minutes ago Goal Last Update less than a minute ago
Created by Work User Deadline Last Updated By  Work User

o) ¢ =
Item Name Unit Price Quantity Line Ttem Total Notes
Laptop $1,439.00 2 §2,598.00 S|t Add
Keyboard $50.45 2 $100.98 Advanced. ..
LCD Monitor £359.00 2 5718.00
Printer £96.50 2 £193.00 Mo items
Mouse £34.00 2 £68.00

Order Total $4,077.98
Add Shipping ]
Information

Submit

Details Additional Information

Mew 0.008 days Open 0 days Pending O days
Description

Figure 2-10. Confirm Order

To see where this point occurs within the overall process, click the Where Am 1

icon at the top of the tab. The You Are Here window opens and displays the
process diagram (Figure 2-11). This is the path that the work item follows. The
shapes in this diagram are types of building blocks in the PRPC representation of
the business process. Common shapes are explained in Chapter 3.

Check marks appear next to those process steps that the work item has passed
through and are complete. Following the diagram from the top downward, the work
item was created, and then was assigned to the Current Operator, Work User.

The first Assignment shape (green rectangle), labeled Enter Item Information,
corresponds to the form where a user must select items and the quantities before
the work item can continue through the process. When you clicked the Submit
button, the work item moved to the next Assignment shape, labeled Confirm
Order. The arrow shape indicates the current step of the flow. The P-1 work item
is at the Confirm Order Assignment.
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PurchaseOrder

Enter Item
Information

@

Enter Item*nfermatien

Confirm Order
\4|,®\

Confirm Crder

————————————————=Manager Review

No Review l

Rewiew

Manager
Approve Order

~——Manager Approve

Updats Status
Completed
=]

| Send
- Correspondenc
o &

Figure 2-11. Location of Request in Process Flow

Rejed

:

Updats Status
Rejeded

—

1. Enter Item Information

Initiated
Date/Time 3512 6:56 AM
User WorkUser@ACORP.com
Routed To WorkUser@ACORP.com
Completed
Date/Time HEM2 708 AN
User WorkUsern@ACORP.com
Proceszed By Work User
Entertteminformation

Action Taken

2. Confirm Order

Initiated
Date/Time H5M2 T:06 AM
User WorkUser@ACORP.com

Fouted To WorkUser@ACORP.com

An Assignment shape (green rectangle) corresponds to a human-based step in
the flow. Assignments are points in the process that are to be handled by a
person (to provide input or take other actions). Here, the Confirm Order
Assignment shape is where a user confirms the order and adds shipping details
to the purchase order request.

7. Click ™% to close the You Are Here window.
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8. Select the Add Shipping Information check box. The Shipping Information
fields appear in the form (Figure 2-12).

9. Type the shipping information for your purchase order. Use the Tab key to
advance from field to field. Do not use the Enter key, as that submits the

form.
=» P-1%
=
‘J Purchase Order (F-1) | Review [ Sav
Case ID P-1 Urgency O w
Created 11 minutes ago Goal
Created by Work User Deadline
Confirm Order Other Actions
Item Name Unit Price Quantity Line Item Total
Laptop £1,499.00 2 £2,998.00
Keyboard 250,49 2 £100.98
LCD Manitor §359.00 2 £718.00
Printer £95.50 2 £193.00
Mouse £34.00 2 £68.00
~Order Total __£4,077,98
Add Shipping
Information
First Name Lisa
Last Mame Kaplan
.-i\ddress Line 101 Main &t
.-;ddress Line Swite #6
City Cambridge
State MA -
Zip Code 02142
Submit

Figure 2-12. Shipping Information
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10. Click Submit. The Confirmation section appears (Figure 2-13). The Status is
Pending-Approval. The form indicates that the work item has gone to a
manager for approval. An assignment for the approval request is placed on the
manager’s worklist.

=l * pP-1%
P
@ Purchase Order (F-1) 4 audit 2 Refresh & Print @ Follow § Tags
Caze ID P-1 Urgency [ U0} I Status P" Pending-Approval I
Created 15 minutes ago Goal Last Update less than a minute ago
Created by Waork User Deadline Last Updated By~ Work User
"
. (=2
W Thank you for your input. L4 ¢ =
R ——
Notes
g + Add
Show: Cases Open Assignments [] Completed Assignments Advanced. ..
Name Assigned To| Deadline Status
E> - Mo items
Approve Order <& Manager
Details Additional Information
New 0,008 days Open 0.003days Pending 0days
Description

Figure 2-13. Pending-Approval Status

In the ASupply Purchase Order process, the purchase order request
automatically routes to a manager for approval when the order total is greater
than $100. (You can test this by creating a second purchase order request with
a total of $100 or less.)

11. Close the form by clicking the Close icon P_1® in the work item tab. Then

click Logoff to log out of the portal (Figure 2-14).

Y

ACOFP Work User -
[ Switch Apps ¥

-

= [ Switch Portal »

[.4] Pul & profie £

Case ID @

Figure 2-14. Logoff
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Approving the Purchase Order Request

Managers or supervisors have access to all of the facilities available to application
users and more. In this sample application, managers have the ability to approve or
reject certain purchase orders.

1. Log into the system as Manager@ACORP.com with the password password to
access the ASupply application as a manager. The Case Manager portal appears
(Figure 2-16).

Managers use different portal tabs and tools than their staff members do. As you
are acting as a manager, you may be prompted with a Windows warning regarding
one or a few additional ActiveX controls. Click Install each time. Figure 2-15
shows an example.

Internet Explorer - Security Warning |

Do you want to install this software?
Mame: PRPC Dr/narnic Menus Yersion 5,5,0,1
Publisher: Pegasystems Inc.

E]MC"'B options Install ] [ Don't Inskall

o While files From the Internet can be useful, this file tvpe can potentially harm
wour computer, Cnly install software from publishers wou trust, What's the risk?

Figure 2-15. ActiveX Control Warning

2. In the ACORP Work Group, click Manager. The manager’s worklist appears in the
work space on the right (Figure 2-16).

El & ACORP Work Group My Work for Today wmq 7d 30d 20d
- o .
Administrator o Case Completion Rate Open Case Timeliness Performance
Business Analyst (@
Created ] Within Goal 1 Rank Not Ranked
Designer (@)
- Completed 0 Past Goal 0 Total Cases Resolved 0
Developer (@) o o

Open 1 PastDeadline 0 Total Cases Resolved on Time 0
@ 0% A B\ 100% 44
System Architect (@ \__/ % Completed 0% \\___/ %% on Time100% | Last Update None

Vice President ()]
) Urgent Work
Wark User (@
El fffy Workbaskets
default@ ACORP. (@ Urgency ~ ID T Description - Goal ~ Deadline ~ Status -
(1))
ault@. .. 0 o w P-1 Purchase Order 2 days from now & days from now P- Pending-Approval
Popular Tags
Mo tags found.

Figure 2-16. Manager’s Worklist
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3. Double-click the purchase order’s work item ID to open it (Figure 2-17).

El & ACORP Work Group My Work for Today wmaq 7d 30d 90d
Administrator )] .
Case Completion Rate Open Case Timeliness Performance
Business Analyst ()
Created 0 Within Goal 1 Rank Not Ranked
Designer @
. Completed 0 Past Goal 0 Total Cases Resolved 0
Developer @ o o
Manager en - / Open 1 - / PastDeadine @ Total Cases Resolved on Time 0
0% 100%
System Architect ()] \\_/ % Completed 0% \\_,/ % on Time100% | Last Update MNone
Vice President (@
) Urgent Work
Work User (@
El fffy Workbaskets
default@ACORP. @ Urgency * ID ~ Description - Goal + Deadline ~ Status hd
ault@ e I o w P-1 Purchase Order 2 days from now 6 days from now r"" Pending-Approval I
Popular Tags
Mo tags found.

Figure 2-17. Open the Purchase Order

4. Click Submit to approve the purchase order request.

P-1%
. T
[J Purchase Order (F-1) | Review [ Save @ Where Am1 € Audit & Print (@ Follow @ Tags
Case ID P-1 Urgency [ U1 Status P" Pending-Approval
Created 46 minutes ago Goal Last Update 30 minutes ago
Created by Waork User Deadline Last Updated By  Work User
& 7 L
- + Add
Advanced...
Item Name Price Quantity Line Item Total
Laptop £1,499.00 2 $2,598.00 No iteme
Keyboard £50.45 2 £100.98
LCD Monitor £359.00 2 £718.00
Printer £96.50 2 £193.00
Maouse £34.00 2 58,00

Order Total $4,077.98

Details Additional Information
Mew 0.008 days Cpen 0.003 days Pending 0 days
Description

Figure 2-18. Approve Purchase Order

The ASupply application displays a confirmation form (Figure 2-19). The resolved
status indicates that the business process is complete.
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=

[J Purchase Order (P-1) @ Reopen ) Audit & Refresh & Print (@ Folow © Tags
Case ID P-1 Urgency @ w0 @ f“" Resolved-Completed
Created 48 minutes ago Goal Last Update ess than a minute ago
Created by Wark User Deadline Last Updated By ~ Manager
Jre)
. (=2
W Thank you for your input. - ﬁ ‘
S —
Notes
- + Add
Show: Cases [#] Open Assignments [F] Completed Assignments Advanced...
Mame Assigned To  Deadline Status
. Mo items
Mo items
Details Additional Information
MNew 0.008 days Open 0.003 days Pending 0.023 days
Description

Figure 2-19. Resolved-Completed Status

Note: In this flow, after a manager Approves (or Rejects) the purchase order request, the work item

becomes resolved with a status of Resolved-Completed (or Resolved-Rejected).

Other tabs and tools in the Manager portal allow managers or supervisors to review
staff members’ worklists, transfer work among staff members, and review real-
time reports about progress, volume, backlogs, and trends.

5. Close the form by clicking the Close ** icon in the work item tab. Then click
Logoff to log out of the portal (Figure 2-20).

Manager -

[ Switch Apps  »
Switch Portal
= ﬁ Al & Profile

Figure 2-20. Logoff

] g
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Chapter 3: Improving the Application

In this chapter, by working as a developer, you will extend the purchase order process
to require a second approval on some purchase orders. To make the application more
closely match ASupply’s business practices, you will modify the process flow to require
a Vice President’s (VP) approval for those purchase order requests that meet all of the
criteria for any row of the following table (Figure 3-1). At least one row must match
the criteria for the purchase order to go to the VP for approval.

Dept Name Bill Customer Order Total
IT >$1,000

HR =>$500
Finance No

Finance Yes =>$200

Legal Yes >$200

Legal No >$200

IT NoO >$2,000

Figure 3-1. ASupply Purchase Order VP Approval Criteria

For example, according to the criteria table:

If...

Then

The Department Name in the submitted VP approval is required, regardless of the total

purchase order is set to Finance

And

The Bill Customer check box is unchecked

(clear)

amount of the order

However If...

The Department Name is set to Finance None of the rows contain criteria that are all met. In
The Bill Customer check box is checked this case, no VP approval is required
The Order Total is $199.00
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When you complete the changes to the application to implement this policy, the
revised process diagram will look like Figure 3-2, with the added shapes shown within
the purple box.

Y

Enter [b=m
Inilynmathan

R

Enttar [tem Information, 100%
Canfinm Oinder
—C

Canfirm Ondar, 100%

- m nagar R!'n'l\!_'!l;:"

Ryl 30

m Hansgar
Mo Rewiaw, 20%
" Apprawe Ondar "

—

Rejec, 0%
HManager Agarave, 51%

r%se.sni-t—fﬁ':l:’_.ﬂ.ppm ardsr

Truze 50%

h ¥

Updats Status : Updats Status
Completsg  pEnagerfoprove, 753 VF Aspnaval }‘%:j::.:i!-‘:' E T —

i
Sand

Carn=spandanc
=

Figure 3-2. Revised Process Diagram
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Changing the Purchase Order Request Process

Follow these steps to learn about the Designer Studio. The Designer Studio is the
portal in which application designers and developers perform their work.

1. Log into the system as Designer with the password password to access the

Designer Studio.

If prompted with a Windows Security warning, click Install. (Figure 3-3 shows an

example.) This might occur a few more times as Windows downloads each needed
ActiveX control.

Internet Explorer - Security Warning FS_(

Do you want to install this software?

Mame: PRPC Open Authoring Yersion 6,1,0,1

Publisher: Pegasystems Inc.

E]Moregjtions Install ] | Don'tInstall |

While files Fram the Inkernet can be useful, this file kype can potentially harm
your computer. Only install software Fram publishers wou trust, What's the risk?

Figure 3-3. ActiveX Control Warning

The Designer Studio opens (Figure 3-4). If the Application Explorer does not
display, click the arrow to select it from the list of Explorers.

ASupply v  Designer =

4

X Q Logout
{Pega
- Application Explorer ¥ |

ACORP-FV-ASupply-Work ¥ What's Happening Application Summary
&[] Data Model

=Y Process [F] Show Fitters ~ EJRSS
# @ Decision

(2 User Interface [ Post |
& Technical R
* £ SysAdmin

=l |5 Application Definition

# PurchaseOrder - Pega: Welcome to PRPC
Vo 62!
Pega

ASupply

Description

Initial implementation of a system that will centralize and automate the purchasing function for corporate employees.

Business Objectives

1 Centralize the purchasing function for employees across the corporation
2 Automate decisioning and routing of purchase orders.

Version: 01.01.01
Rule Set: ASupply
) Created: 2/13/2012 5:24 PM by Administrator
I Updated: 2/26/2012 11:21 AM by Administrator

Detailed History

Figure 3- 4. Designer Studio

The Application Explorer in the left panel provides quick access to this application’s
rules. It presents a multi-level tree structure to browse for and perform operations
on rules. Rules are organized into PRPC rule categories.

For example, the ASupply application contains the PurchaseOrder class which
contains rules that belong to various rule type categories such as Process,
Decision, and User Interface (Figure 3-5).
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ACORP-FW-ASupply-Work &
# [[] Data Model
H ;h Process
+ 4 Decision
* 7] User Interface
* E Technical
* £ SysAdmin
+ |5 Application Definition
=l PurchaseOrder
# [[] Data Model
H 55 Process
+ 4 Decision
* F] User Interface
* || Reports
* & Technical
* &1 SysAdmin

Figure 3-5. Process Rule Category in the Application Explorer
2. Open the PurchaseOrder flow rule (Figure 3-6):

a. Click the + icon to expand the PurchaseOrder class and see the categories it
contains.

b. Click the + icon to expand the 7 Process category to see the rule types it
contains.

c. Click the + icon to expand the Flow rule type. In the Application Explorer, a
green arrow icon ¥ preceding a name indicates a starter flow rule, which
supports the creation of a new work item.

d. Click ® PurchaseOrder to open the flow rule.

ACORP-FW-ASupply-Work &
# [[] Data Model
*# ;9 Process
H 4 Decision
# F] User Interface
+ @& Technical
+ &1 SysAdmin
# = Application Definition
= PurchaseOrder
# [[] Data Model
=l 1 Process
=1 Elowy o
I PurchaseOrder |
* Case Type
# validate
+ 4§ Decizion
* 7] User Interface
# & Technical
2 £ SysAdmin

Figure 3-6. PurchaseOrder Flow Rule in Application Explorer
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The Flow rule form for the PurchaseOrder process opens (Figure 3-7).

ﬁ Flow ACORP-FW-ASupply-Work-PurchaseOrder sPurchaseOrder

Diagram Parameters Pages & Classes Design Prodg

B R = - | [ (2% =1

Enter Item
Infomation

Enter Item In™mation, 100%
"

Confirm Ord=r

@

Confirm Order, 1008

'lg:ljlqer Rz vimwa

No Review , 208

F— Manager &pprove, G0% ™ R jmct, 40
h | L

P "y # “y

Update Status Update Status
Completed Rejected
© | ©

—_———— :
Send L
Cormespond=nc
o = |

., o

Figure 3-7. PurchaseOrder Flow Rule

PRPC has dozens of rule types; each type is identified in the text label at the
upper left of the corresponding form (in this case, Flow).

Tabs on the form provide access to rule fields and information organized by
function. Tools on the Designer Studio toolbar enable you to find, create,
change, or delete rules and data instances. The PurchaseOrder flow rule is

marked read-only ({3'), so you cannot alter this instance directly. Instead, you
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will save a copy of this flow rule into a RuleSet named ASupply with a higher
RuleSet Version of 01-01-02. Then you make updates to the new copy.

3. Click Save As (= to save a copy of the flow rule into the
ASupply:01-01-02 RuleSet Version. A SaveAs dialog opens (Figure 3-8).
Flow: SaveAs

Fitter Bty: Implementation
Applies To | BCORP-FW-ASupply-Work-PurchaseOrd:

Flowy Mame  PurchaseCrder

ASupply:01-01-02

4

« Availability

Available Yes -

Status -

} Date Range

L Save As j[ Cancel

Figure 3-8. Flow: Save As Dialog

4. The Applies To and Flow Name fields identify the keys of the flow rule. Do not
alter the values in these fields. The new flow rule should use the same keys as the
original you are copying. Confirm that ASupply displays in the RuleSet drop-down
list and the Version is 01-01-02, and then click Save As.

The new flow rule appears. Select the arrow to collapse the details.

u Flow ACORP-FW-ASupply-Work-PurchaseOrder sPurchaseCOrder

The next steps change the PurchaseOrder flow to include a Decision shape that
determines whether the VP must approve a purchase order request.

A Decision shape, represented in the process diagram by an orange diamond,
identifies an automatic step where processing may advance along any one of two
or more outcomes. In this case, the Decision shape has two outcomes:

» VP approval is required (True)

» VP approval is not required (False)

5. In the View area on the Diagram tab, make sure that Modeler is selected.

View == Discovery Map %0 Modeler

The process diagram displays.
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6. Using the mouse wheel, scroll towards you to reduce the size of the process
diagram, so that you can view the entire process.

7. In the toolbar, make sure that the Pan icon {mf] is selected. Left-click a blank area
of the canvas and drag to move the diagram as a whole. You can use the mouse
wheel to re-size the diagram again, if desired. You can also pan the diagram using
the mini-map in the lower right.

For details about using the Process Modeler, click the Help icon in the toolbar,
select Developer Help, and go to the Flow Rules — Process Modeler Basics topic.

Developer Help...

Pega Developer Network 2

Figure 3-9. Developer Help

left-click a blank area of the canvas and drag to form a selection boundary. When
you release the mouse button, the selected shapes are highlighted and you can
take action; for example, move or delete, on all the highlighted shapes
simultaneously. You will work with Select mode later.

8. In the toolbar, verify that Draft On is selected. While the flow rule is in
draft mode, it is known as a flow model, and you can reference other rules and
flow actions that you have not yet defined.
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9. Review the process diagram.

Flow Start Shape —}'M /'

Enter It=m
Infomation
oy

Emter ItenPinformatio

o y

Confirm Order

R

n“iﬂﬁn Ehlp.., C:rriri Order

—

Assignment Shape

Manager Review

No Review
#
Manager
Bpprove Onder
e
—_— |l
I it
- Manager Approve o Fmjmct -
. | #
Update Status Update Status
Compl=t=d Reject=d
o o

|_‘ ~ S=nd |. J
—>< ul.__rr::p;_r__r_ |'-

Figure 3-10. Process Modeler Process Diagram

The green circle at the top of the process diagram identifies the start of the
business process in which a new purchase order request is created. Processing
of each purchase order proceeds along the connectors from shape to shape.

The three green rectangles with clocks on them mark Assignment shapes
(Enter Item Information, Confirm Order, and Manager Approve Order).
Assignments are the steps in the process that require a human actor (here, a
user or manager) to enter information or record their decisions. The orange
diamond shape labeled Manager Review identifies an automated Decision. In
this process, the automated Decision has two outcomes: Review or No Review.

Fast Start Guide




10. In the toolbar, click = to open the Shapes palette. To pin the Shapes palette so
that it is always visible, double-click the Shapes icon, and then drag the Shapes
palette to the desired location, as shown Figure 3-11. You can hover the mouse
pointer over each shape to view a descriptive ToolTip.

u v Flow ACORP-FW-ASupply-Work-PurchaseOrder sPurchaseOrder

E

o X

D Aszignmert

< Decigion

Subprocess

@ ¢

Enter Iktem
Information

Liility

Swyimlane

1l

Enter Iterm Infermation, 1002

() Start
Confirmm Order O End
Confirm Order, 100% @ Split For Each

Split Join

anager Revie -
& | Irtegrator
E Azsignment Service

= Annotation

.

Faview, 80%

Manager

%

Approve Order

Figure 3-11. Pinned Shapes Palette
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11. Before adding a new Decision shape to the flow, create some space in the diagram.

In the toolbar, click the Select i mode. Click to the left of the process diagram,
underneath Manager Approve, and drag to select the remainder of the flow:
Update Status Completed, Update Status Rejected, Send Correspondence, and
their connectors, as shown in Figure 3-12.

¥

Manager
bsprove Dl"d__rr
_r@
— Marnsger Aoporove, GUY = R i, 40 .L
Updale Status Updale Sialus l
Compieted | fmjected
e § e
| | Send | |
| Cormsgondenc [+ =
|.n =

Figure 3-12. Select Shapes to Move

12.When you release the mouse, selected areas of the flow are highlighted in blue.

Hover the mouse pointer over the highlighted area until it changes to a cross QED
and then click and drag the selected area down.

B — B —

Update Status

Update Status
Rejected

Comp e be:d

=

Figure 3-13. Click and Drag Shapes
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The bounding box shown in Figure 3-14 indicates the new location.

i ]

Manager
fpprove Order

e O

— Mansjer Agprove, 0%

i,

Jet, 0% I
L | 3 ¥

Ic.l

Updal= Status Updals Stalus
Complated Fimjected [
L L /

b — =

Figure 3-14. Bounding Box Indicates New Location

13. From the Shapes palette, drag a Decision shape <_~ onto the process diagram,
positioning it below the Manager Approve Order Assignment shape (Figure 3-15).
This indicates that the business process requires a decision after a purchase order
request is approved by the manager.

Manager
Approve Order

Approve, 60%%— — Reject,

<>

Figure 3-15. New Decision Shape

14.Hover the mouse pointer over the Decision shape until it changes to a cross <'%>
and then double-click the Decision shape to display the Decision Properties panel.
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< o

< [Decisigal
-

Figure 3-16. Mouse Pointer Becomes a Cross

15. In the Decision Properties panel, specify the following items as shown in
Figure 3-17:

a. Type VP Approve Order in the Name field. This is the text that displays
on the shape in the process diagram, the work item history display, and the
Where Am | diagram.

b. Select Decision Table as the Type.

c. Type VPApproveOrder in the Rule field (Figure 3-17).

Decision Properties
Mame VP Approve Order
| |
Type Decision Table -
Rule# VPApproveOrder [
Result In [
Audit Mote [
Entry Point [
[ ok ” Zancel

Figure 3-17. Decision Properties Dialog

At this point, the flow rule references a decision table rule, but the decision table
rule does not yet exist. Next, you’ll create the decision table rule.

16. In the Decision Properties dialog, click the Open icon | next to the Rule field. You
will create a new decision table rule with that name (Figure 3-17).

Rule# VPApproveQrder
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17.In the New Decision table dialog, confirm or enter the following:

» Do not change the Applies To field
» The Purpose field should be VPApproveOrder; if not, change it
» The RuleSet should be ASupply; if not, change it

» The Version should be 01-01-02; if not, change it

Decision Table: New

Fitter By: Implementation
Applies To - ACORP-FW-ASupply-work-PurchaseCrd

Furpose  WPApproveOrder

* RuleSet Version

RuleSet ASupply A
Version 01-01-02 - ASupphy:01-01-02
. .Avalla bllil:v ..........................................................................................
Available Yes -
Status -
Create ][ Cancel

Figure 3-18. New Decision Table Dialog

18. Click Create. The Decision Table rule form appears (Figure 3-19).

u DECISION TABLE ACORP-FW-ASupply-Work-PurchaseOrder = VPApproveOrder ASupply : 01-01-02 ®
C Applies To ACORP-FW-ASupply-Work-PurchaseCrder Circumstance
= Purpose \PApproveOrder Last Update

Short Description VP ApproveOrder

Table Results Pages&Classes History

= i - [ Show Conflicts ][ Show Completeness ]
Conditions Actions
o Return
oif —
otherwise —+

Figure 3-19. Decision Table Rule Form
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Defining a New Decision Table Rule

1. In the Decision Table rule form, click the Results tab to bring it to the front.
Complete two rows of the Allowed Results array to identify the allowed results
for this decision table. In this case, the allowed results are:

» True: This purchase order requires VP approval
» False: This purchase order does not require VP approval

When completing arrays, click:
B _ to add a new row at the bottom of the array
e _ to insert a new row between existing rows

) _ to delete a row

2. On the Results tab, type True in the first row, click 2 to add a new row, and
then type False in the second row.

B¥  DECISION TABLE ACORP-FW-ASupply-Work-PurchaseOrder = VPApproveOrder

Applies To ACORP-FW-ASupply-Work-PurchaseOrder
< >' s
Purpose VPApproveOrder

Short Description VPApproveOrder

| Results__ I

Allowed Values Property J\E8
Allowed Results ngds ties? LTS
=2 : Evaluate All Rows I
1 b e A o Allowed to Update Row Layout  |[v
B 2. b Fakel i ] i Allowed to Update Column Layout |[v
= Allowed to Change Property Sets |[v
Allowed to Build Expressions rd
Allowed to Return Values v
PRESET PROPERTY VALUES
Property Value
1 i y

Figure 3-20. Decision Table Rule — Results

Note: No changes are needed to the Set Properties?, Options, or Preset Property Values areas.
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3. Click the Table tab to bring it to the front. In this tab, you record the decision
table logic as presented previously in Figure 3-1:

Dept Name Bill Customer Order Total
IT >$1,000

HR >$500
Finance No

Finance Yes >$200

Legal Yes >$200

Legal No >$200

IT No >$2,000

Figure 3-21. Decision Table Logic

4. The decision table in this example has three inputs that are identified by property
rules: DepartmentName, BillCustomer, and OrderTotal. Each column in the decision
table (except the Return column) corresponds to a property. Use these steps to
complete the Table tab:

a. Click the column heading cell (the cell just below the Conditions column
title) to label the column in the matrix. A Property Chooser pop-up dialog
displays (Figure 3-22).

| Table | | |

o

. Show Conflicts ” Show Ct

Conditions Actions

Iu\l | Return

o if - b

otherwise & ™QecisionTable Property Chooser -- Webpa... [é]
* Select a Property

Property | 4
Label

Use Range |

Use Operator = -

Save Cancel

.

Figure 3-22. Decision Table Property Chooser
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b. With the mouse pointer in the Property field, press the Down Arrow key
(V) to use the SmartPrompt control to access a list of available properties.
When DepartmentName (Figure 3-23) is highlighted, press Enter to select
it. You can also double-click to select an item from a SmartPrompt control.

£ | DecisionTable Property Chooser -- Webpage Dialog ﬁ
Settings
Select a Property

Property | PRE
__ ACORPFW-ASupply-Work -
Bill Customer
Departmentiame
DepartmentMumber
ItemDetails -

Use Operator =

[ Save ] [ Cancel ]

Figure 3-23. Select A Property — Decision Table Property Chooser

After you choose the DepartmentName property, the Label field displays a
default value.

Note: The green triangle at the bottom right corner of the Rule field is a SmartPrompt control.

SmartPrompts appear on many rule and data forms to provide a selection list for fast entry. To

complete a field that contains this control, press your keyboard’s Down Arrow key to access the

list. For the Property field here, this SmartPrompt control displays a list of available properties

from which you can select.

c. Click Save to save the property to the decision table matrix.

5. The starting table contains a single input conditions column. You need to add two
columns; one for the BillCustomer property and one for the OrderTotal property.

To add a column to the right of the starting column:

a. Click the cell under Department Name to select that column (Figure 3-24).

[ Table | ] ]

St e D 11 T o] | Show
Conditions Actions
~ Departmentlame Return

o if —F

otherwise ¢ —+

Figure 3-24. Decision Table Rule — Select A Column
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b. Click the Insert Column After icon 4. A new column appears to the right
of the starting column. Do this again to add a second column (Figure 3-25).

Table I I
=2 o T
B o | % # H 1| ggell . [ Show Conflicts ” Show Completeness ]
Conditions Actions
Departmentlame Return
iF —*
otherwise Y

Figure 3-25. Decision Table Rule — Insert Column After

6. Add the BillCustomer and OrderTotal properties (Figure 3-26) to the columns using
the Property Chooser (Figure 3-22).

= [ Show Conflicts ][ Show Completeness ]
Conditions Actions
Departmentame @ @ Return
if —+
otherwise —+

Figure 3-26. Decision Table Rule — Add Properties To Columns

7. Enter the first decision criteria (shown in Figure 3-21) to complete the first row of
your decision table:

a. Click in the first cell under Department Name. The SmartPrompt appears
in the cell. Use the SmartPrompt (press the Down Arrow key) to display the
selection list and enter the name IT.

b. Under Bill Customer, leave the entry blank for this row.

c. Type =>1000 for the entry under Order Total. (Omit the dollar sign,
commas, and pennies in the amount.)

d. In the Actions Return column, select True for the value (Figure 3-27).
There are only two allowed return actions, True and False, which are
defined by the results that you specified earlier on the Results tab.

| Table l l

B o | ‘% Tr' [ Show Conflicts H Show Completeness ]
Conditions Actions
Departmentilame BillCustomer OrderTotal Return
if I »1000 — |[True
otherwise —

Figure 3-27. Decision Table Rule — First Row Completed
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8. Add additional rows by clicking the Insert Row After icon #. Add six rows, as
shown in Figure 3-28.

[ Table _ I I

S o | B [ #H 2 [l ] Show Conflicts ” Show Completeness l
Conditions ____ Actions
o Departmentlame © BillCustomer o OrderTotal Return
o if T =1000
- else if
o else if
o glse if
- else if
o else if
- else if
otherwise

True

44

Figure 3-28. Decision Table Rule — Empty Rows Added

9. Using Figure 3-1 as your guide, complete the table so it looks like Figure 3-29. In
the Bill Customer column, enter =False for No and =True for Yes. In the
otherwise (final) row, set the return action to False.

[ Table _ I I

Ein + T | show Conflicts ][ Show Completeness ]
Conditions Actions
o Departmentlame  ~ BillCustomer o OrderTotal Return
o if Im =1000 —+* | True
o else if HR. =500 —+* | True
o else if Finance =Falze —+* | True
o else if Finance =True =200 —+* | True
o glse if Legal =True =500 —+ | True
o glse if Legal =Falze =200 —+ | True
o glse if I =Falze =2000 —+ | True
otherwise —+ | False

Figure 3-29. Decision Table Rule Completed
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10. Click Save Bto save the updated decision table rule. An icon at the top of the
form indicates that the rule was saved, but with a warning. Click the + sign to view
the warning.

n + » DECISION TABLE ACORP-FW-ASupply- Work-PurchaseOrder = VPApproveOrder

: Applies To ACORP-FW-ASupply-Wark-PurchaseOrder
vy Purpose VPApproveQrder

ﬁ Valid{Warn) Short Description VPApproveCrder

— AThere is 1 warning

A Logic: This rule contains 1 logic conflict. Click Show Conflicts to see details,

Table Results Pages & Classes History

-— | = [ Show Conflicts ][ Show Completeness ]
Conditions Actions
o Departmentlame  °© BillCustomer o OrderTotal Return
o if T 1000 —+ |[True
o else if HR. =500 —+ | True
o else if Finance =False —+ | True
o else if Finance =True =200 —+ | True
o eglse if Legal =True =500 —+ ||True
o eglse if Legal =False =200 —+ ||True
o else if I =False =2000 —+ | True
otherwise —+ | False

Figure 3-30. Decision Table Rule Warning
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11. Click Show Conflicts to check this rule for logic consistency (Figure 3-31). One
logic error appears in the bottom row (indicated by a warning icon *: ). The bottom
row contains an unreachable condition. It has a combination of input values that
cannot be used. The top row is reached first (IT and order total > 1000) and masks
the bottom row (IT and order total = 2000).

Table l l
= ( Show Conflicts H Show Completeness ]
Conditions Actions
Departmentiame BillCustomer OrderTotal Return
if T =1000 —+ || True
else if HF. =500 —+  ||True
else if Finance =False — |[True
else if Finance =True =200 — |[True
else if Legal =True =500 — |[True
else i Legal =False =200 — |[True
Chelseit > | —False >2000 — | Tre
otherwise —+ ||False

Figure 3-31. Decision Table Rule — Logic Errors

12.To delete this row, click in any cell in the row to select the row, and then select the

Delete Row icon # . Click Show Conflicts again to confirm that no logic errors
remain. A message displays: “The Decision Table is consistent.”

13. Save the revised decision table and close the rule form by clicking the X.

& VPApproveOrder

14. Click OK to close the Decision Properties dialog.
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Editing the Flow

1.

Move the Manager Approve connector from the Update Status Completed
Utility shape to the VP Approve Order Decision shape. To do this, select the
Manager Approve connector. The connector displays in blue and connection
points appear as dots at either end of the connector.

Y

~—Manager Approve, 60%—" ——

_—-'"'/f/\\“‘x.
Approve Ordé
‘W\FD o dep
T
Update™ =
Com
L : =7

Figure 3-32. Select Connector

Click and drag the connection point from the Update Status Completed Utility
shape to the top connector of the VP Approve Order Decision shape. A connector
must make a valid connection to a shape. Valid connections display with a green
connector line and a green outline around the target shape (Figure 3-33).

No Review, 20%

Manager
Approve Order

—Manager Approve, 60%—

/ .
Approve Ora“

Update Status
Completed

e

Figure 3-33. Move Connector
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3. Select and drag an Assignment shape below the VP Approve Order Decision
shape, so that purchase order requests can be routed to the Vice President (Figure
3-34).

-
Mo Rmvimwe , 2000
Reject, 405
Manager Approve, 60%
z—v " s ¥ gt
Update Status Update Status
ﬁﬁ:rmpleted Rejected

L cens | T
Correspond=nc [*
e <= |

Figure 3-34. Add Assignment Shape
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4. Hover the mouse pointer over the Assignment shape until it changes to a cross Q%E')
and then double-click the Assignment shape and complete the Assignment
Properties. On the Assignment tab, complete the following (Figure 3-35):

a. Name: Type VP Approval.

b. Harness Name: Use the SmartPrompt to select Perform. (A harness rule
provides the basis of a form for work item processing.)

c. Instructions: Type VP Approval Pending (do not include punctuation).
This text will appear in the Confirm user form.

d. Confirmation Note: Type VP Approval is required (do not include
punctuation).

Assignment Properties

Mame WP Approval

Assignment | |
Type WorkList -
Parameters
Harness Mame  Perform [
Instructions VP Approval Pending [
Confirmation Mote WP Approval is required [
Do Mot Perform [

Service Level  Default [
Effort Cost [=

Entry Point
Only Going Back []

Post Action on Click Away []

Figure 3-35. Assignment Properties

5. In the Status tab, use the SmartPrompt to select Pending-Approval as the Work
Status.

Assignment Properties

MName WP Approval

Work Status  Pending-Approval [

Figure 3-36. Assignment Properties — Status
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6. In the Routing tab, use the SmartPrompt to select ToOVP as the Router, and then
click OK to apply the assignment properties.

Assignment Properties

Mame VP Approval

Routing |

Router ToVP [

Figure 3-37. Assignment Properties— Routing

7. Add a connector from the VP Approve Order Decision shape to the Update
Status Completed Utility shape, as shown in Figure 3-38. To add a connector,
click and drag a gray arrow on the VP Approve Order Decision shape and drop it
on the Update Status Completed Utility shape.

l

e UF Approve Ordsr

) L
Update Status

Compleled 1
o

+

Figure 3-38. Add Connector

8. Double-click the connector to open the Connector Properties and configure this
connector as shown in Figure 3-39. Set the Likelihood to 50. A likelihood is a value
between 1 and 100. It reflects an assumed or known probability of the human
actor taking that action.

]

—D."P Spprove Ordsr

Connector Properties

MName False
Update Status
Comgleted Connector

|\ Condition Type Result

Result False|
Likelihood# 50

Audit Mote

Figure 3-39. Configure Connector
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9. This configuration means that when the decision table rule returns a value of False,
the Vice President’s approval is not required. The following events occur

automatically: The request’s status is updated to Resolved-Completed and the
purchase order request is resolved, as shown in Figure 3-40.

h 4

Fals=, S0t — —AF Approve Ordsre

Update Status
Compll=i=d
o

Figure 3-40. Updated Process Diagram

10. When the decision table rule returns a value of True, the Vice President’s approval
is required. Add a connector from the VP Approve Order Decision shape to the
VP Approval Assignment shape as follows:

) I
Connector Properties

—AP Approve Ordsr
Mame True

, \

WP ﬁpprwal Condition Type Result
‘—{ P
= Result True
Likelihood#* 50

Figure 3-41. Configure Connector

11.From the VP Approval Assignment shape, add a connector to the Update Status
Rejected Utility shape.
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12. Double-click the connector to open the Connector Properties dialog. In the Flow
Action field, press the down arrow, double-click More, and then double-click to
select Reject.

Connector Properties
Mame  [Flow Action]
|
Flow Action# | [
- PreviousOperator
Application PurgeMullFlows
Wark Tvpe pxWhereAmIChevronView
v pyAddManualCaseFromMay
Specification pyAssignmentlistGadget
pyCmAddCoveredWork
Likelihood # | pyCmCancelAssignment
pyCmComplete
Audit Mote | pyMoveToAnotherCase
pyPreviewPane
pyUpdateSubjectDetails
pyWithdrawFromMav
pyWorkMotes
F‘.eEnﬁaieExternalForInformaﬁon

Figure 3-42. Reject Flow Action

13. In the Likelihood field, type 25, and then click OK. PRPC uses the likelihood values
to determine the order of actions in the action list in the user interface.

P . I SE—
. Update Status
WP Approval }‘R_—jz:’t.l?ﬁ'{ pF'_-je:‘t:f ‘
oy
—t
Rty |

Figure 3-43. Likelihood

14. Add a connector from the VP Approval Assignment shape to the Update Status
Completed Utility shape. Configure the connector as follows:

Connector Properties

Mame Manager Approve

Flow Action#® ManagerApprove
Application  ASupply

Wark Type

Spedfication

Likelihood+# | 75|

Audit Note

Figure 3-44. Configure Connector
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15. Click 5 to save your changes to the process.

Mo Ryl

Entar [b=im
Infinma than

©

Enter Item Infarmatian, 100%

‘CanfinmOind =

©

Canfirm Ordar, 100%

- w

R=wvizk Z03:

w, 20%

HManager Spprave, 51%

| Falss, EG%W
509%

Undate

= | rj—
Status
Campleted VP Appaval | [-Rejece, E%'{

L 4

Updats Status
Amjm oo

HManager Aoprave, 75%

ZS=nd
Carre=gpand=nc

[

Figure 3-45. Updated Process Diagram
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Test Your Process Changes
Test your process changes using the Run menu.

1. Click the Run icon E] in the Quick Launch bar, select Run Process, and then
select Purchase Order. You do not need to log out, but can act as the work user,
manager, and VP.

Run Process b Purchaze Crder |
Open Portal bk

Peemalg
| |

Performance
My Alerts

Figure 3-46. Run Menu

2. Create a new purchase order request, using data values similar to those entered in
the example in Chapter 2.

3. Enter line items and quantities that produce a total amount that meets one of the
criteria for requiring VP approval as shown in Figure 3-1. For example, if the
Department is IT, any order over $1000 requires the VP’s review.

4. Click Submit to confirm the purchase order request.

5. Click the Approve Order link displayed at the bottom of the confirmation note
that indicates the purchase order is assigned to the manager (Figure 3-47). As a
manager, approve the request.

Show: |:| Cases Open Assignments |:| Completed Assignments
Name Assigned To

E:> Approve Order 5 Manager

Figure 3-47. Approve Order Link

6. Verify that after the manager approves the purchase order request, the request is
routed to the Vice President for approval.

Show: Cases Open Assignments |:| Completed Assignments
Name Assigned To

L4 VP Approval Pending 4+ Vice President

Of course, more complete testing of every condition in the decision table rule is
required in real-world development situations.

You may log off now or continue with the next chapter. To log off, click the Logout
link in the upper right area of the Designer Studio.
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Chapter 4: Updating the User Interface

Currently, the Vice President sees the same user interface as the manager when
approving or rejecting a purchase order request. However, ASupply’s business policy
requires the VP to enter an approval code. The business policy also gives the VP the
option to enter a note about the approval.

In this chapter you will enhance the user interface to enable the VP to enter these
details.

Building a New Flow Action rule

Recall from Chapter 2 that assignments are points in the process that are to be
handled by a person (to provide input or take other actions). Rules known as flow
actions determine which inputs are requested from the user in the work item form as
the user completes the assignment.

To provide the VP the opportunity to enter input during the VPApproval assignment, a
new flow action rule is needed to implement those details.

1. Log in as Designer with the password password, as in Chapter 3.

2. From the Application Explorer tree in the left panel, click the + icon to expand the
PurchaseOrder class.

3. Click the + icon to expand the El User Interface category, right-click Flow
Action, and select New from the context menu (Figure 4-1).

=l PurchaseOrder
# [[] Data Model
) Gh Process
# 4 Decision
= [F] User Interface
+ Flow Action

e} ],,_ Reports View
# & Technica
5 5 Sysadmi  CXPand
Define Properties

Refresh ACORP-FW-ASupply-...
Refresh All

Figure 4-1. Flow Action Context Menu

4. The New flow action rule dialog opens (Figure 4-2). Specify the following:
a. Keep the Applies To value as it is.
b. For the Action Name, type VPApprove.
c. For the RuleSet, select ASupply.

d. For the Version, select 01-01-02.
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Flow Action: New

Fitter By: Implementation
Applies To - ACORP-FW-ASupply-work-PurchaseOrd:

Action Mame \-'PApprove|

~ RuleSet Version

RuleSet ASupply -
Version 01-01-02 - ASupply:01-01-02
s
MName i
v Availability L mmmmmmmmmmmmmmmmm—m——ee
Available Yes -
Status -
[ Create ][ Cancel ]

Figure 4-2. New Flow Action Dialog

5. Click Create to create the new VPApprove flow action and display the rule
form. In the Short Description field, insert a space between VP and Approve.
This label, VP Approve, will display in the flow action section.

u FLOW ACTION ACORP-FW-ASupply-Work-PurchaseOrder = VPApprove ASupply : 01-01-02 ®
Applies To ACORPFW-ASupply-Work-PurchaseOrder  Circumstance
1 L Action Name VPApprove Last Update

Short Description VPApprove

Layout HelpSetup Action Security HTML |Pages & Classes History

i = I ], ==6], | T2€.)

< drag section here >

Figure 4-3. VPApprove Flow Action Rule Form

6. Click Save B . At this point the new VPApprove flow action rule does not
display user interface items for the VP to enter information. Section rules are
used to implement user interface features for a flow action. Next, you will
create a section rule.
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Building a Section rule

1. From the Application Explorer tree in the left panel, click the + icon to expand the
PurchaseOrder class.

2. Click the + icon to expand the |E| User Interface category, right-click Section,
and select New from the context menu (Figure 4-4).

=l PurchaseOrder
# [[] Data Model
* Y Process
@ Decision
= EF] User Interface
2 Flows Action

# Section
4 5 T
2 £ Sysa) View ‘
Expand
Define Properties

Refrezh ACORP-FW-ASupply-...
Refresh All

Figure 4-4. Section Context Menu
3. The New section rule dialog opens (Figure 4-5). Specify the following:
a. Keep the Applies To value as it is.
b. For the Purpose, enter VPApproval.
c. For the RuleSet, select ASupply.

d. For the Version, select 01-01-02.

Section: New 2

Fitter By: Implementation
Applies To - ACORP-FW-ASupply-Work-Purchase Ord:

Purpose  WPAppraval|

= RuleSet Version

RuleSet ASupply -

‘ersion 01-01-02 - ASupply:01-01-02

Available Yes -

Status -

[ Create ” Cancel ]

Figure 4-5. New Section Dialog
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4. Click Create to create the new VPApproval section and display the rule form in the
Designer Studio (Figure 4-6). An initial layout appears on the Layout tab.

5. Click Save @ to save the VPApproval section rule.

SECTION ACORP-FW-ASupply-Work-PurchaseOrder » VPApproval ASupply : 01-01-02 ®

d oy
T it -8 Applies To ACORPFW-ASupply-Work-PurchaseOrder  Circumstance
”.:, PLity Purpose VVPApproval Last Update
Short Description VPApproval

[ Layout i | - HTML

[ t=T= I e Y=

LABEL FIELD LABEL FIELD

Figure 4-6. VPApproval Section Rule Form

6. Add a field in which the VP is required to enter an approval code. To do this, click

the Basic icon =¥ in the toolbar, select the Text Input Control and drag it to

the Field column cell in the top row, as shown in Figure 4-7.

S | DEE @ | e 20 === O e
LABEL FIELD LABEL FIE |Gii:|__ Label
. e )
o | Text Input o b [
- |abc | Textinput |

Figure 4-7. Text Input Control
7. In the Field column, click the magnifying glass icon - in the first row to open
the Cell Properties panel. In the Property field, type .ApprovalCode (using the
exact case and being sure to include a leading period).

FIELD

Cell Properties E N
Property ApprovalCode @
Conkral peTextInput RIS

Figure 4-8. Cell Properties Panel

8. Click the Open icon Ff next to the Property field (Figure 4-8). This opens a
New property rule dialog (Figure 4-9).
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Property: New

Fitter Bry: Implernent ation
Applies To ACORP-FW-ASupply-Work-PurchaseCrd

Property Mame  ApprovalCode

~ RuleSet Version

RuleSet  ASupply

Mersion 01-01-02

+ Quick Create

Type Text -

+ Reporting
|:| Optimize this property for reporting on ACORP-FW-ASupply-Work-PurchaseOrder

|:| Optimize this property for reporting on ACORP-FW-ASupply-Work-PurchaseOrder and

- Availability

Available Yes -

Status -

@ Create ][ Cancel ]

Figure 4-9. New Property Dialog

9. Make sure that ASupply is selected in the RuleSet field and that 01-01-02 is
selected in the Version field. Click Quick Create to create the new property
rule (Figure 4-9).

10. In the Cell Properties panel, select the General tab, and then select the
Required check box. This ensures that a value is entered in the user form
before it is submitted. Otherwise, an error message appears and reminds the
user to enter a value. Close the Cell Properties panel.

Cell Properties b=
Property ApprovalCode #
Zonkral paTextInpuk AN
Behavior X\
Wisible: Blways -

Edit Options Auko -

Figure 4-10. Select the Required Check Box

11. In the Label column, click the magnifying glass icon " next to Text Input to
open the Cell Properties panel. In the Cell Properties panel, change the Value
from Text Input to Approval Code, as shown in Figure 4-11. On the General

tab, notice that the Required check box is selected. A required icon () will
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display next to the label in the user interface. Close the Cell Properties panel.
1
R o |02 ! | e g |

LABEL FIELD

o JText Input +

Cell Properties -
Yalue approval Code =
Label For JSApprovalCode #
[ General
Wisible: Always -

[v Required

[ Read Only

Figure 4-11. Change the Value

12. Select the Approval Code cell and then click the Insert Row After icon # to
insert a row below Approval Code.

EiE (@@ i _E

LABEL FIELD

o JApproval Code -4

Figure 4-12. Insert Row After

LABEL FIELD

o JApproval Code % 5y
[n}

[u]
Figure 4-13. New Rows Added to the Layout

13. A property rule named PaymentDate already exists. You can drag and drop it
from the Application Explorer into the new row below Approval Code. In the
Application Explorer, click the + icon to expand the PurchaseOrder class, and

then click the + icon to expand the L Data Model category to see the
Property rule type.

14. Click the + icon to expand the Property rule type (Figure 4-14). Each blue dot
* identifies a simple property rule, one that holds only a single value such as a
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date or amount. Other icons in this tree, such as 2], identify aggregate
properties, which are similar to arrays and structures.

Select the * blue dot to the left of the PaymentDate link. (Do not click the
PaymentDate link.)

=l PurchaseOrder
=[] Data Model
= Property «
* AddShipping
* ApprovalCode
# =] Contactinformation
(E)Pa:.rmentl}ate

Figure 4-14. Payment Date Property

The blue dot turns yellow, indicating that it is selected. Drag and drop it into
the second row of the Field column.

 j& Application Definition
=l PurchaseOrder
= [ Data Model
=l Property «
= AddShipping
* ApprovalCode
=] Contactinfermati

LABEL FIELD

o JApproval Code =Y

o

Figure 4-15. Drag and Drop .PaymentDate Property

This row now contains the .PaymentDate property. Notice the calendar icon in
the Field column. This indicates that the .PaymentDate property is a
pxDateTime Control. PRPC supports a wide variety of input and output formats
for dates and times.

LABEL FIELD

o | Approval Code *

o PaymentDate &

Figure 4-16. .PaymentDate pxDateTime Control
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15. In the Label column, click the magnifying glass icon "~ next to PaymentDate

to open the Cell Properties panel. Change the Value to Payment Date (insert a
space), and then close the Cell Properties panel.

LABEL FIELD

2 Approval Code %

2 PaymentDate @ =
a Cell Prupeﬂ% || = I

Yalue Pavment Dake

Y
Label For PaymentDate [#

Figure 4-17. .PaymentDate pxDateTime Control

16. From the Basic panel, drag a Text Area Control to the cell in the third row of
the Field column.

LABRSL FIELD LABEL gre | Label Label
o Approval Code % Text Input
° Payment Date +
/ ~ | Text Area

=
[u} /

Figure 4-18. Add the Text Area Field

3

Icon

17.In the Label column, click the magnifying glass icon " next to the Text Area
cell to open the Cell Properties panel. Change the Value to Note and then close
the Cell Properties panel.

i o /[0 i | (R e |

LABEL FIELD
o Approval Code *

o .Payment Date

o Text Area
Cell Properties B
Yalue =
Label For pvTemplatelnputBox [

Figure 4-19. Change the Text Area Label

18. In the toolbar, click Save = to save the updated VPApproval section rule form.
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19. Click the Preview button LQ in the toolbar to view the effect of your changes
in the bottom half of the portal (Figure 4-20).

D-DQE @ BRER® ] » @5

ASupply : 01-01-02 ®

=== ) 2E .

o | Approval Code %

o Payment Date @

© Note

4 {LLI ‘lr »

Preview: VPApproval

5]
K|T|

Approval Code*
Payment Date 3]

Mote

Figure 4-20. Preview

20. Click the x on the VPApproval tab to close the section rule form.
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Adding a Section rule to a Flow Action

Now that the section is created, add it to the VPApprove flow action so that the
Approval Code and Note user interface elements display as the VP completes the
assignment.

1. Return to the VPApprove flow action rule form by clicking its tab in the Designer
Studio (Figure 4-21).

ASupply +  Dezigner

Application Explorer » L | VPApprove

Figure 4-21. VPApprove Flow Action Rule Form

2. In the Application Explorer, expand the Section rule type to locate the newly
created VPApproval section. Select the blue dot = to the left of the VPApproval
section in the Application Explorer. Each blue dot identifies a single rule. The blue
dot turns yellow, indicating that it is selected. Drag it into the VPApprove flow
action rule form, dropping it onto the <drag section here> area (Figure 4-22).

=l PurchaseOrder
* [[] Data Model
5 Process o
+  Decision | =
=l [F User Interface < drag section figre >
# Flow Action e
=l Section
& ConfirmiteminformationSecti
ConfirmOrder
Enteriteminfor
& Kana prove
fpingDetailSection
PApproval

Figure 4-22. Drag VPApproval Section into VPApprove Flow Action

3. When you release the mouse button, the VPApprove flow action rule form displays
a section reference to the VPApproval section (Figure 4-23).
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u FLOW ACTION ACORP-FW-ASupply-Work-PurchaseOrder = VPApprove

I Applies To ACORP-FW-ASupply-Wark-PurchaseOrder
4 Achion Name VPApprove

Short Description VP Approve
Layout HelpSetup Action Security HTML Pages & Classes

- |

o Section Reference [ACORP-FW-ASupply-Work-PurchaseOrder.WVPApproval] 8,
LABEL FIELD LABEL

o Text Input

© Payment Date

C

© Mote

Figure 4-23. VPApprove Flow Action with Section Reference to VPApproval

4. Save the VPApprove flow action by clicking @ .

5. Click the x on the VPApprove tab to close the VPApprove flow action rule form.

Editing the Flow

At this point, the new flow action VPApprove is complete, but not referenced by any
shape in the flow rule. In this section you will update the PurchaseOrder flow rule so
that the new VPApprove flow action runs when the VP approves a purchase order
request.

1. Open the PurchaseOrder flow using the Application Explorer.

2. Double-click the Manager Approve connector to display the Connector Properties.

T .anagerﬁppr-:we, 7540 ) VP Approval

Figure 4-24. Manager Approve Connector

Update Stat
Completed

3. In the Connector Properties panel, type VP Approve in the Name field, use the
SmartPrompt to replace ManagerApprove with VPApprove, and then click OK
(Figure 4-25).
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Connector Properties

Mame | VP Approve
low Action® VPApprove [

Application  ASupply

Work Type
Spedfication [
Likelihood# 75
Audit Note [&i

[ 2K ” Zancel

Figure 4-25. VP Approve Connector Properties

The connector in the process diagram is labeled VP Approve.

Figure 4-26. VP Approve Connector

4. Click Save to save your changes to the flow rule.

5. Test the revised process to verify that the VP is now required to enter an Approval
Code and an optional note when approving a purchase order request.

To complete the test:

a. Click the Run icon F in the Quick Launch bar and select Run Process >
Purchase Order.

b. Create a purchase order request that requires VP approval. The
requirements are stated in the decision rule table you created in Figure 3-
29. For example, enter HR as the Department Name and select one laptop,
which requires VP approval because it is over $500.

Fast Start Guide




c. As manager, approve the request. It is now assigned to the VP.

Show: Cases Open Assignments [ | Completed Assignments

Mame Assigned To

* VP Approval Pending 4 Vice President

Figure 4-27. VP Approval Pending

The VP is now required to enter an approval code and may also enter an
optional note (Figure 4-28).

Approval Code | |
Payment Date | Ell

MNote

Submit

Figure 4-28. Approval Code

d. Enter a note and click Submit to finish the process.

Inspecting Declarative Rules

This application calculates several properties with declarative rules, which are rules

that define calculations among property values. For example, each LineltemTotal is the
value of the item’s Price multiplied by Quantity.

To see the list of declarative rules, go to the Application Explorer, select the ASupply-
FW-ASupply-Work class, expand the Decision category, and then expand the
Declare Expressions category as shown in Figure 4-29.

ACORP-FW-ASupply-Work &
[[] Data Model

G Process

=l ¢ Decizion

E .
#= |ineltemTotal .Order()
* (OrderTotal

Figure 4-29. Declare Expressions in Application Explorer
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To open a rule from the Application Explorer, click the rule name. Figure 4-30 and
Figure 4-31 show the .OrderTotal and LineltemTotal.Order() rule forms respectively.

¥  DECLARE EXPRESSIONS ACORP-FW-ASupply-Work «.OrderTotal »

Expressions Pages & Classes Change Tracking History

fEaE

Whenever inputs change

Set .OrderTotal = Sum of .Order().LineltemTotal

Figure 4-30. Declarative Expression for .OrderTotal

¥  DECLARE EXPRESSIONS ACORP-FW-ASupply-Work s .LineltemTotal ».Order()

Expressions Pages & Classes Change Tracking History

£6 0@

Whenever inputs change

Set .LineltemTotal = Value of .Quantity™®. UnitPrice

Figure 4-31. Declarative Expression for .LineltemTotal

Like formulas in a Microsoft Excel spreadsheet, properties controlled by declarative
rules are computed automatically whenever a value changes that affects the
computation. For example, the target property LineltemTotal is computed whenever
the Price or Quantity changes. Similarly, you don’t need to create an explicit program
to recalculate the OrderTotal after you input a quantity.

Using the Declarative Rules Inspector

You can use the Declarative Rules Inspector to see which properties in the work item
form are dependent upon these rules, and to graphically illustrate those dependencies.

1. To enable the Declarative Rules Inspector, click the I Run icon in the Quick
Launch bar and select Rules Inspector = Declarative Rules (Figure 4-32).

Run Process

Open Portal

race Open Rule

I Rules Inspector PI HTHL Rulezs

Performance Property Rules

WMy Alerts v Declarative Rules I

Field Value Rules
Styles

Figure 4-32. Declarative Rules Inspector
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2. Create a new purchase order request by selecting # > Run Process > Purchase
Order. On the work item form, a “D” link appears next to each property that is
calculated by a declarative rule.

For example, assume that you select the Laptop item and type 2 as the quantity.
Notice that a D appears next to the LineltemTotal property (Figure 4-33). Click the
“D” link to inspect how that property value is calculated.

LI WETTE Price Quantity Line Item Total
Laptop v |  $1,499.00 E tgz,g-aa.nu
Order Tot £2,558.00

Figure 4-33. Reviewing Declarative Rules

After clicking the “D”, the Dependency Network Viewer opens and shows the
Dependency Network for the LineltemTotal property (Figure 4-34).

‘:'_] Order{1)
% LineltemTotal = $2,998.00
&
Quantity = 2

LinitPrice = £1,499.00

Figure 4-34. Dependency Network Viewer

The symbols shown are described below:

» A function symbol ( % ) references a declarative rule.

» The arrows show how computations depend on each other — where results from one
computation feed into inputs of a later computation.

PRPC supports complex declarative rules and enables you to test and debug
declarative computations interactively.

To disable the Declarative Rules Inspector feature, click P > Rules Inspector >
Declarative Rules.
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Chapter 5: Reviewing Your Application

By following Chapters 3 and 4 in this tutorial, you used rule forms and the Process
Modeler to refine the ASupply application. PRPC uses sophisticated industry-standard
technologies to implement your changes without requiring you to directly specify
coding-level details. You do not need advanced IT skills to produce applications that
are functional, easy to use, and visually appealing.

Developing Applications by Changing Rules
You created a few new rules in the ASupply RuleSet that include the following:
» A decision table rule, VPApproveOrder, controls which purchase order requests are
routed to the VP for review.
» A property rule, ApprovalCode, holds an input value entered by the Vice President.

» A flow action, VPApprove, prompts the VP with two new fields after the VP approves a
purchase order request.

» A section, VPApproval, provides the user interface for the VPApprove flow action.

These new rules supplement the original set of rules in the ASupply RuleSet, which
defined the application before you changed it. As you will see in Chapter 6,
Documenting Your Application, and from the application document in Appendix A, the
ASupply RuleSet contains about 125 rules.

The Application Explorer provides designers and developers with quick access to rules
in the ASupply RuleSet. These rules, in turn, build on hundreds of built-in, out-of-the-
box standard rules that are present in every PRPC system and which form the
foundation building blocks of applications.

Technology Under the Covers

If you are familiar with the technologies mentioned below, you can appreciate the
power and breadth of PRPC as a development environment.

» A property rule (for example, the ApprovalCode property) corresponds to a scalar
variable.
» Flow action rules are converted to HyperText Markup Language (HTML).

» The Process Modeler representation of a business process is converted internally to an
XML (eXtended Markup Language) document that later becomes a Java class.

» Rules and other data are stored in a relational database supported by any of several
popular database products from Oracle, Microsoft, or IBM.

» Computations, such as declarative rules and decision table rules, are transformed into
efficient Java programs.
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The architecture

Autogenerated Controls simplify design and maintenance, eliminating the need for
hand-coding, improving performance, and ensuring browser independence and
compatibility.

Grid layouts enable users to view and edit values of a Page List or Value List property
or a Report Definition in a spreadsheet format. Grids are created dynamically and
have as many rows as needed to display the requested data.

and design of PRPC provides these benefits:

Inheritance and polymorphism enable you to build applications by overriding or
extending existing rules. For example, the flow rule that you saved into the higher
RuleSet Version overrides (supersedes) the initial flow rule that was delivered with the
ASupply application.

Through hardware clustering, one PRPC system can support thousands of users in
multiple locations who enter, work on, and resolve millions of work items.

Applications can be developed iteratively with incremental enhancements.

Developers can use the Run menu in the Quick Launch bar to quickly switch from a
development task to a testing task and back to a development task, as you did.

PRPC applications can interface with other systems using a wide variety of industry-
standard technologies (such as SOAP / Web services, e-mail, relational databases,
J2EE facilities including Enterprise JavaBeans, and JavaServer Pages).

Fast Start Guide




Chapter 6: Documenting Your Application

PRPC includes tools that enable you to easily document what you have built. This
chapter describes how to use those tools.

Note: Microsoft Word 2002 or later is needed to produce the Application document.

Documenting the ASupply Application

7,
1. In the Designer Studio, select the Pega button * and then select Application >

Tools = Document (Figure 6-1).

D ASupply v  Developer ¥

g Show Al
K - .
o o Overview » nINg
- ;J
a 1 [[] Show Fitters Xt
Process & Rules 3 Profile »
— [
= ;
==—| Data Model 3 ;\i Structure 3
elcome to PRPC 6.2
u User Interface 4 @ Inwentory »
ﬂ Reporting 4 Guardrails 4
_,/
"‘ Integration L4 g Development L4
u Org & Security 4 E Import and Export 4
ol Specification List
3 5
System = Specification Matrix

Regquirements List
Requirements Matrix

List Extensions
All Wizards

Browser Compatibility Report
Accessibility Report

Figure 6-1. Document Menu Item
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2. In the Application Document wizard, select the ASupply application, the ASupply
application template, and specify the Detail Level, for example, Full Application
Documentation.

For more information about the Application Document wizard, click the Help button

in the upper right of the wizard.

ASupply +  Designer «

# Document an Application

ﬁ Order P Define y. Capture y.

Get Started: The application document wizard specifies which application data content you would like

In this Step: Selectwhich items from the application you would like to include in the generated Micros(
your own sections and attachments to include in the document.

— Application
Select an Application

Select a Template ‘ASupply application -

|

— Options
Detail Level & Full Application Documentation -
| Section headings will display Short Description -
Suppress Class and RuleSet references r

Create links to rule forms within document [

— Rule 5ets

Make Selection

v ASupply
v ASupplylnt
v ACORP
v ACORPInt

Figure 6-2. Application Document Wizard

3. Click the Order chevron at the top of the screen to proceed to the next page.

Define r, Capture .,

Figure 6-3. Order Chevron
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4. Select the items that you want to include in the document and then click the
chevron to proceed through the Define and Capture screens.

" Select ﬁ Defing Capture Actions » | w
In this Step: Select which items from the application you would like to include in the generated Microsoft Word Document You can select from the standard selection items or customize and add
your own sections and attachments to include in the document

[ & adachapter | [ &) Addsubchapter | [ Resetorder | [ & Refresh | 'I“"C‘[;‘:;

Document Selections Selected Type r

@ Application Overview Oveniew v
E PurchaseOrder Wrk Type v
E Common Supporting Type v
B Security Supporting Type v
=] Navigation Supporting Type v
= DataManagement Supporting Type v
EI SysAdmin Supporting Type v
& Requirements Matrix Requirements v
& Reports Reports v
& Correspondence Correspondence v
& Integration Integration v
& Decisions Decisions v
@ Security Security v
S SLAs SLAs I7
@ Activities Activity v

¢ Cancel ) [ Save J [ << Back ) [ Hext >> ) [ Document Now 3 E

Figure 6-4. Application Document Wizard

5. After you have specified all the information that you want to include in the Word
document, click the Document Now button at the bottom of the screen.

( Document Now )

Figure 6-5. Document Now Button

PRPC generates a Word document that lists all of the rules in the application. The
generation process may take a minute or two. A message displays when the
documentation is complete. Appendix A contains the document created by PRPC for
the ASupply application.

6. Click the Logout link in the upper right corner of the Designer Studio.

This is the conclusion of the Fast Start Guide. More information on the ASupply
application and appendices describing the Designer Studio toolbar, tab bar, and the
typical workstation setup can be found in the following pages.
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Appendix A: Application Document for
ASupply

The following pages show the document created by PRPC for the ASupply application.

Note: Page breaks, page numbering and fonts in the generated ASupply document have

been modified for inclusion in this book.
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J» APPLICATION DOCUMENT A4S

Application Document for
ASupply
01.01.01
ASupply

Created by: Designer
On March 12, 2012
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© Copyright 2013
Pegasystems Inc., Cambridge, MA

All rights reserved.
This document describes products and services of Pegasystems Inc. It may contain

trade secrets and proprietary information. The document and product are protected by
copyright and distributed under licenses restricting their use, copying distribution, or
transmittal in any form without prior written authorization of Pegasystems Inc.

This document is current as of the date of publication only. Changes in the document
may be made from time to time at the discretion of Pegasystems. This document
remains the property of Pegasystems and must be returned to it upon request. This
document does not imply any commitment to offer or deliver the products or services
described.

This document may include references to Pegasystems product features that have not
been licensed by your company. If you have questions about whether a particular
capability is included in your installation, please consult your Pegasystems service
consultant.

For Pegasystems trademarks and registered trademarks, all rights reserved. Other
brand or product names are trademarks of their respective holders.

Although Pegasystems Inc. strives for accuracy in its publications, any publication may
contain inaccuracies or typographical errors. This document or Help System could
contain technical inaccuracies or typographical errors. Changes are periodically added
to the information herein. Pegasystems Inc. may make improvements and/or changes
in the information described herein at any time.

This document is the property of:
Pegasystems Inc.

101 Main Street

Cambridge, MA 02142-1590

Phone: (617) 374-9600
Fax: (617) 374-9620
WWww.pega.com
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Application Overview

Description
Initial implementation of a system that will centralize and automate the purchasing function for corporate employees.

Business Objectives

e Centralize the purchasing function for employees across the corporation
e Automate decisioning and routing of purchase orders

Actors
Actor Type Count Access Method
Employee Operator 2000 Total Users Per Week [ Browser
Manager Operator 50 Total Users Per Week Browser

Case Type Definitions

Case Type Prefix Starting Process
Work Pool: ASupply (Work Pool: ASupply) C-
ASupply (ASupply) C- No Processes Defined.
Purchase Order (Purchase Order) P- PurchaseOrder
Work Types
Name Implementation Class

PurchaseOrder | ACORP-FW-ASupply-Work-PurchaseOrder

Supporting Types

Name Description
Common Specifications shared by multiple work types
Security Specifications dealing with authentication, authorization
Navigation Specifications specific to getting between work types and general application processing

DataManagement | Specifications specific to managing lists of products, reference data tables, broadcast messages

SysAdmin Specifications specific to managing operator profiles, calendars, skills, rule migration/promotion
RuleSets
RuleSet | Version Description Prerequisites

ASupply  [01-01-02 | RuleSet to identify, manage, and control the set of rule | Pega-ProcessCommander:06-02-20
instances that define ASupply application ASupplylnt:01-01-01

ASupplylnt [ 01-01-01 | Integration RuleSet for ASupply framework Pega-ProcessCommander:06-02-20
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RuleSet | Version Description Prerequisites
ACORP:01-01-01
ACORP | 01-01-01 | Created by Initial Setup Wizard Pega-ProcessCommander:06-02-20
ACORPInt | 01-01-01 [ ACORPInt Pega-ProcessCommander:06-02-20
Requirements
ID Name Category | Status Description
ApprovalLevel | ApprovalLevel |Business Complete | Pruchase requests are routed to managers based on total dollar values as
Rule described in the corporate accounting manual
Purchaseltems | Purchaseltems | Business New The list of items an employee can request is based on the employee's
Rule grade level.
RejectReason | RejectReason | Business New A list of reject reasons is presented to managers and fulfillment operators
Rule who select from the list.
PurchaseOrder
Implementation: ~ ACORP-FW-ASupply-Work-PurchaseOrder

Description: Edit this Description

Purchase Order - Flow

Rule Name: PurchaseOrder
Applies to Class:  ACORP-FW-ASupply-Work-PurchaseOrder
RuleSet: ASupply : 01-01-02
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Flow Diagram

Primary Path

Start

Implementation:  New
Referenced By: Purchase Order - Flow (Page 76)

Rule Name: New
Applies to Class: ~ ACORP-FW-ASupply-Work
RuleSet: ASupply : 01-01-01

Enter Item Information - Assignment
Implementation:  WorkList
Parameters:
DoNotPerform = false
Instructions = Enter item information
HarnessPurpose = Perform

default service level - SLA
Referenced By: Enter Iltem Information - Assignment (Page 77) in Purchase Order - Flow (Page 76)
Rule Name: Default
Applies to Class: ~ Work-
Long Description:  Default service level
Usage: The goal is that each work object will be completed in two days.
The deadline is that each work object must be completed within 5 days.

Fast Start Guide




RuleSet:

Initial Urgency: 0

Pega-ProCom : 06-02-01

Assignment is ready for work:

Goal Deadline Late
Interval from when assignment is ready Repeating interval from Deadline
Days | 2 5
+HH:MM:SS|0:0:0 0:0:0
In Business Days? | Yes Yes No
Urgency |0 0
Escalation Activity

Perform work object - Harness
Enter Item Information - Assignment (Page 78) in Purchase Order - Flow (Page 76)

Referenced By:
Rule Name:
Applies to Class:
RuleSet:

[J ASupply
Case ID
Created

Created by

Case Contents

Perform
ACORP-FW-ASupply-Work
ASupply : 01-01-01

Urgen
lez= than a minute

Goal
ago
Developer Deadli

cy @ 0

ne

Show: {ased [v] Open Assignmentz [ | Completed Assignments

Hame

No items

New 0 days

De=cription

Assigned To Deadline

Open 0 days

Pending

Status

La=t Update

La=t Updated By

L&

Hotes

r‘ Newr

@

i

Status

No items
0 days
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Enter Item Information - Transition
Implementation:  EnterltemInformation
Referenced By: Purchase Order - Flow (Page 76)

Rule Name: EnterltemInformation
Applies to Class:  ACORP-FW-ASupply-Work-PurchaseOrder
RuleSet: ASupply : 01-01-01
tem Hame # Price Cuantity = tem Total
| 50.00 o
e,

Order Total 30.00

Confirm Order - Assignment

Implementation: ~ WorkList
Parameters:

DoNotPerform = false
Instructions = Confirm order
HarnessPurpose = Perform

default service level - SLA
Referenced By: Confirm Order - Assignment (Page 77) in Purchase Order - Flow (Page 76)

See default service level (Page 77)

Perform work object - Harness
Referenced By: Confirm Order - Assignment (Page 78) in Purchase Order - Flow (Page 76)

See Perform work object (Page 78)
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Confirm Order - Transition

Implementation: ~ ConfirmOrder
Referenced By: Purchase Order - Flow (Page 76)

Rule Name: ConfirmOrder

Applies to Class: ~ ACORP-FW-ASupply-Work-PurchaseOrder

RuleSet: ASupply : 01-01-01

tem Hame Unit Price Quantity Item Total
$0.00

Order Total 50.00

Add Shipping’

information

Manager Review - Decision

Implementation: ~ ManagerReview
Referenced By: Purchase Order - Flow (Page 76)

Rule Name: ManagerReview
Applies to Class: ~ ACORP-FW-ASupply-Work-PurchaseOrder
RuleSet: ASupply : 01-01-01

« if .OrderTotal > 100 then RETURN review
otherwise RETURN noreview

Manager Approve Order - Assignment
Implementation: ~ WorkList
Parameters:
DoNotPerform = false
Instructions = Approve Order
HarnessPurpose = Perform
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default service level - SLA
Referenced By: Manager Approve Order - Assignment (Page 77) in Purchase Order - Flow (Page 76)

See default service level (Page 77)

Perform work object - Harness
Referenced By: Manager Approve Order - Assignment (Page 78) in Purchase Order - Flow (Page 76)

See Perform work object (Page 78)

Manager Approve - Transition
Implementation: ~ ManagerApprove
Referenced By: Purchase Order - Flow (Page 76)

Rule Name: ManagerApprove
Applies to Class:  ACORP-FW-ASupply-Work-PurchaseOrder
RuleSet: ASupply : 01-01-01

» Shipping Detail
» Department Information

tem Hame Price Quantity Item Total
£0.00

Order Total $0.00

VP Approve Order - Decision
Implementation: ~ VPApproveOrder
Referenced By: Purchase Order - Flow (Page 76)

Rule Name: VPApproveOrder
Applies to Class: ~ ACORP-FW-ASupply-Work-PurchaseOrder
RuleSet: ASupply : 01-01-02
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Conditions Actions

DepartmentName | BillCustomer | OrderTotal | | Return
if IT >1000 True
elseif |HR >500 True
elseif |Finance =False True
elseif |Finance =True >200 True
elseif |Legal =True >500 True
elseif |Legal =False >200 True
Otherwise False

Update Status Completed - Utility
Implementation:  UpdateStatus
Parameters:
StatusWork = Resolved-Completed
Referenced By: Purchase Order - Flow (Page 76)
Rule Name: UpdateStatus
Applies to Class: ~ Work-
Long Description:  Update the status of a work item, and call Resolve if it has been Resolved.
Usage: The activity gets called from various places including Work-NewAssign, Work-NewAssignBasket etc. It sets the status and calls
another activity 'RecalculateAndSave' to update the urgency, timestamps and to save the work object.
RuleSet: Pega-ProcessEngine : 06-02-20

Decides what action to take based on pyworkstatus - Tree
Referenced By: Updates the status of a work item - Activity (Page 82)

Rule Name: pyCheckResolvedStatus
Applies to Class: ~ Work-
RuleSet: Pega-ProcessEngine : 06-02-01

« if "Resolved-Completed” then RETURN "check"
« if "Resolved-Withdrawn" then RETURN "cancel”
« if "Resolved-Duplicate" then RETURN "cancel"
« if "Resolved-Revoked" then RETURN "cancel”

« if "Resolved-Rejected" then RETURN "cancel"
otherwise RETURN "other"

Send Correspondence - Utility
Implementation:  CorrCreateAndSend
Parameters:

SendAllAttachments = false

SendNow = true

Broadcast = false

CorrName = Acknowledgement

PartyRole = Customer

Referenced By: Purchase Order - Flow (Page 76)
Rule Name: CorrCreateAndSend
Applies to Class: ~ Work-
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Long Description:
Usage:

Creates a single correspondence
This activity is called by CorrNew activity. It creates the correspondence record and calls the activity CorrUpdate.
RuleSet: Pega-ProcessEngine : 06-02-01

Alternate Path 1

VP Approval - Assignment
Implementation:  WorkList
Parameters:
DoNotPerform = false
ConfirmationNote = VP Review is required
Instructions = VP Approval Pending
HarnessPurpose = Perform

default service level - SLA
Referenced By: VP Approval - Assignment (Page 77) in Purchase Order - Flow (Page 76)

See default service level (Page 77)

Perform work object - Harness
Referenced By: VP Approval - Assignment (Page 78) in Purchase Order - Flow (Page 76)

See Perform work object (Page 78)

VP Approve - Transition

Implementation:  VPApprove
Referenced By: Purchase Order - Flow (Page 76)

Rule Name: VPApprove
Applies to Class:  ACORP-FW-ASupply-Work-PurchaseOrder
RuleSet: ASupply : 01-01-02
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Approval Code# | |

Payment Date | Ell

Note

Alternate Path 2

Reject - Transition
Implementation:  Reject
Referenced By: Purchase Order - Flow (Page 76)
Rule Name: Reject
Applies to Class:  Work-
Long Description:  This flow action is for rejecting the work object.
Usage: Used by the StandardEvaluate flow. Approval flows should use the Disapprove flow action, not Reject.
RuleSet: Pega-EndUserUl : 06-02-01
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Usage:

Rejection Note

el
*

Clarifications

Problem Rea.sunl

Update Customer Satisfaction Status

FromNew

To| New W

Set the resolved properties - Activity

Referenced By: Reject - FlowAction (Page 84)

Rule Name: ActionResolve

Applies to Class:  Work-

Called by the flow action Resolve/Reject/ResolveAsDuplicate.

casad created in 050401
RuleSet: Pega-ProCom : 06-02-01

Update Status Rejected - Utility

Implementation:  UpdateStatus

Parameters:

StatusWork = Resolved-Rejected

Referenced By: Purchase Order - Flow (Page 76)

See Updates the status of a work item (Page 82)
Alternate Path 3
Reject - Transition

Implementation:  Reject
Referenced By: Purchase Order - Flow (Page 76)
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See Reject (Page 84)

Set the resolved properties - Activity
Referenced By: Reject - FlowAction (Page 84)

See Set the resolved properties (Page 85)

Other Specifications referenced in the application (outside
of a Process)

ApproveOrder - Specification

Rule Name: ASupply | PurchaseOrder | ApproveOrder
RuleSet: ASupply : 01-01-01

Details

Actors: Manager

Triggers: Web Browser

Complexity: Medium

Description

Manager must approve order totaling more than $100

ConfirmOrder - Specification

Rule Name: ASupply | PurchaseOrder | ConfirmOrder
RuleSet: ASupply : 01-01-01
Details

Actors: Employee

Triggers: Web Browser

Complexity: Low
Description
Not Yet Defined

EnterDeptinformation - Specification

Rule Name: ASupply | PurchaseOrder | EnterDeptinformation
RuleSet: ASupply : 01-01-01

Details

Actors: employee

Triggers: Web Browser

Complexity: Low

Description
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Department information is defaulted into the purchase request form but the employee can overwrite it if not correct.

EnterltemInformation - Specification

Rule Name: ASupply | PurchaseOrder | EnterltemInformation
RuleSet: ASupply : 01-01-01

Details

Actors: Employee

Triggers: Web Browser

Complexity: Medium

Description

Enter the items to purchase.

PurchaseOrder - Specification

Rule Name: ASupply | PurchaseOrder | PurchaseOrder
RuleSet: ASupply : 01-01-01

Details

Actors: Any

Triggers: Web Browser

Complexity: Low

Description

Enter department information

RejectOrder - Specification

Rule Name: ASupply | PurchaseOrder | RejectOrder
RuleSet: ASupply : 01-01-01
Details

Actors: Manager

Triggers: Web Browser

Complexity: Low
Description
Not Yet Defined
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Entity Relationship Diagram

ACORP-FW-ASupply-Work-PurchaseOrder

ACORP-Data-Order

+*pylD

+AddShipping
+ApprovalCode
+BillCustomer
+DepartmentName
+DepartmentNumber
+OrderDate
+OrderTotal
+PaymentDate
+UrgencyAssign

+Contactinformation : Data-Party
+Order : ACORP-Data-Order
+pyWorkParty : Data-Party

+*pyLabel
+ltemName
+LineltemTotal
+Quantity
+UnitPrice

Data-Party

+*pyWorkPartyUri

0.x

Classes Referenced In Diagram: ACORP-Data-Order, Data-Party

Properties Referenced

Rule Name Label Mode Type RuleSet
AddShipping AddShipping Single Value | TrueFalse ASupply
ApprovalCode ApprovalCode Single Value | Text ASupply
BillCustomer BillCustomer Single Value | TrueFalse ASupply
ContactInformation ContactInformation Page Data-Party ASupply
DepartmentName DepartmentName Single Value | Text ASupply
DepartmentNumber DepartmentNumber Single Value | Text ASupply
Order Order PageList ACORP-Data-Order | ASupply
OrderDate OrderDate Single Value | Date ASupply
OrderTotal OrderTotal Single Value | Decimal ASupply
PaymentDate PaymentDate Single Value | Date ASupply
pyActionPrompt Action Single Value | Text Pega-WB
pyAttachmentType Attachment Type Single Value | Text Pega-ProCom
pyCaption Window Caption Single Value [ Identifier Pega-RULES
pyConfirmationNote Confirmation Note Single Value | Text Pega-ProCom
pyDescription Description Single Value | Text Pega-RULES
pyElapsedStatusNew Elapsed in Status New Single Value | Decimal Pega-ProCom
pyElapsedStatusOpen Elapsed in Status Open Single Value | Decimal Pega-ProCom
pyElapsedStatusPending | Elapsed in Status Pending | Single Value | Decimal Pega-ProCom
pyID Work ID Single Value | Text Pega-ProCom
pylIncludeSubCases pyIncludeSubCases Single Value | TrueFalse Pega-EndUserUl
pylnstructions Instructions Single Value | Text Pega-ProCom
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Rule Name Label Mode Type RuleSet
pyLabel Label Single Value | Text Pega-ProCom
pyNote Routing/Transfer note Single Value | Text Pega-ProCom
pyOrigUserID Originating User ID Single Value | Text Pega-ProCom
pyProblemReason Problem Reason Single Value | Text Pega-ProCom
pyRootCause Root Cause Single Value | Text Pega-ProCom
pySelected Selection Flag Single Value | TrueFalse Pega-ProCom
pySLADeadline SLA Deadline Single Value | DateTime Pega-ProCom
pySLAGoal SLA Goal Single Value | DateTime Pega-ProCom
pySpecialtyComponentData | pySpecialtyComponentData | Single Value | Text Pega-UIEngine
pyStatusCustomerSat Customer Satisfaction Status | Single Value | Text Pega-ProCom
py StatusWork Work Status Single Value | Text Pega-ProCom
pyTemplatelnputBox InputboxTemplate Single Value | Text Pega-UlDesign
pyWorkIDPrefix Work ID Prefix Single Value | Text Pega-ProCom
pyWorkParty Parties PageGroup | Data-Party Pega-ProCom
UrgencyAssign Urgency of Assignment Single Value | Decimal ASupply

Common

Description: Specifications shared by multiple work types
Security

Description: Specifications dealing with authentication, authorization
Navigation

Description: Specifications specific to getting between work types and general application processing
DataManagement

Description: Specifications specific to managing lists of products, reference data tables, broadcast messages
SysAdmin

Description: Specifications specific to managing operator profiles, calendars, skills, rule migration/promotion
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Requirements Matrix

Requirement | Category | External | Status Description Linked To
ID
ApprovalLevel [ Business Complete | Pruchase requests are routed to managers based on total | ASupply 01.01.01 (
Rule dollar values as described in the corporate accounting Application)
manual
Purchase Business New The list of items an employee can request is based on the | ASupply 01.01.01 (
ltems Rule employee's grade level. Application)
RejectReason | Business New A list of reject reasons is presented to managers and ASupply 01.01.01 (
Rule fulfillment operators who select from the list. Application)
Reports
List Views
Applies To Name Description RuleSet
ACORP-Data-Lineltem DataTableClassEditor Added by wizard ASupply
Details

Summary Views

None found

Report Definitions

None found

Correspondence

Acknowledgement
Acknowledgement Email

Rule Name:

Applies to Class:

RuleSet:

ACORP-FW-ASupply-Work

ASupply : 01-01-01
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Good day. Purchaze order haz been created on your behalf.

Integration

Services
None found

Connectors
None found

Decisions
Tables

VPApproveOrder
Rule Name: VPApproveOrder

Applies to Class:  ACORP-FW-ASupply-Work-PurchaseOrder

RuleSet: ASupply : 01-01-02

Conditions

Actions

Fast Start Guide




Conditions Actions

DepartmentName | BillCustomer | OrderTotal | | Return
if IT >1000 True
elseif |HR >500 True
elseif |Finance =False True
elseif |Finance =True >200 True
elseif |Legal =True >500 True
elseif |Legal =False >200 True
Otherwise False

Trees

Manager Review

Rule Name: ManagerReview
Applies to Class: ~ ACORP-FW-ASupply-Work-PurchaseOrder
RuleSet: ASupply : 01-01-01

« if .OrderTotal > 100 then RETURN review
otherwise RETURN noreview

Map Values

None found

Whens

ItemPrice
Rule Name: ltemPrice
Applies to Class: ~ ACORP-Data-LineltemDetails
RuleSet: ASupply : 01-01-01
Logic: A0
A0: true = @(Pega-RULES:ExpressionEvaluators).compareTwoValues(.ltemName, "=", "Laptop")
Security
Access Group Role Name

ACORPApp:Administrators PegaRULES:SysAdm4

Pega-Feedback:PegaDeveloper

ACORPApp:BusinessAnalysts [ PegaRULES:SysArch4

Pega-Feedback:PegaDeveloper
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Access Group

Role Name

ACORPApp:Managers

PegaRULES:WorkMgr4

ACORPApp:SystemArchitects

PegaRULES:SysArch4

ACORPApp:Users

PegaRULES:User4

ASupply:Administrators PegaRULES:SysAdm4
PegaRULES:User4
PegaRULES:WorkMgr4

SLAs
None found

Activities

Applies To Name Description RuleSet Version
ACORP-Data-Order CopyUnitPrice CopyUnitPrice ASupply 01-01-01
Purchase Order ToVP BPM Routing API: Assign [ ASupply 01-01-01
to Assigned Operator

ASupply getltemDetails getltemDetails ASupply 01-01-01

Properties

Applies To Name Description Mode RuleSet Version
ACORP-Data-Lineltem | ltemName [tem Name String ASupply 01-01-01
Details
ACORP-Data-Lineltem | Price Price String ASupply 01-01-01
Details
ACORP-Data-Order ItemName [temName String ASupply 01-01-01
ACORP-Data-Order LineltemTotal LineltemTotal String ASupply 01-01-01
ACORP-Data-Order Quantity Quantity String ASupply 01-01-01
ACORP-Data-Order UnitPrice UnitPrice String ASupply 01-01-01
ACORP-FW-ASupply- | AddShipping AddShipping String ASupply 01-01-01
Work-PurchaseOrder
ACORP-FW-ASupply- | ApprovalCode ApprovalCode String ASupply 01-01-02
Work-PurchaseOrder
ACORP-FW-ASupply- | Contactinformation | Contactinformation Page ASupply 01-01-01
Work-PurchaseOrder
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Applies To Name Description Mode RuleSet Version
ACORP-FW-ASupply- | PaymentDate PaymentDate String ASupply 01-01-01
Work-PurchaseOrder
ACORP-FW-ASupply- | UrgencyAssign Urgency of Assignment | String ASupply 01-01-01
Work-PurchaseOrder
ACORP-FW-ASupply- | BillCustomer BillCustomer String ASupply 01-01-01
Work
ACORP-FW-ASupply- | DepartmentName DepartmentName String ASupply 01-01-01
Work
ACORP-FW-ASupply- | DepartmentNumber | DepartmentNumber String ASupply 01-01-01
Work
ACORP-FW-ASupply- | ltemDetails [temDetails PageList ASupply 01-01-01
Work
ACORP-FW-ASupply- | Order Order PageList ASupply 01-01-01
Work
ACORP-FW-ASupply- | OrderDate OrderDate String ASupply 01-01-01
Work
ACORP-FW-ASupply- | OrderTotal OrderTotal String ASupply 01-01-01
Work

Declaratives

Expressions

.LineltemTotal

Rule Name: .LineltemTotal .Order()
Applies to Class: ~ ACORP-FW-ASupply-Work
RuleSet: ASupply : 01-01-01

Execute this expression: Only when the top-level page is of the Applies To class
Calculate value: Whenever inputs change

Set .LineltemTotal = Value of .Quantity*.UnitPrice

.OrderTotal
Rule Name: .OrderTotal
Applies to Class: ~ ACORP-FW-ASupply-Work
RuleSet: ASupply : 01-01-01

Execute this expression: Only when the top-level page is of the Applies To class

Calculate value: Whenever inputs change
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Set .OrderTotal =

Triggers

None found

OnChange

None found

Constraints
None found

Specifications Matrix

Application | Work Type Specification Linked To | Flow Shape

ASupply PurchaseOrder | ApproveOrder

ASupply PurchaseOrder [ ConfirmOrder

ASupply PurchaseOrder | EnterDeptinformation

ASupply PurchaseOrder | EnterltemInformation

ASupply PurchaseOrder | PurchaseOrder

ASupply PurchaseOrder | RejectOrder
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Appendix B: The Designer Studio Toolbar
and Tab Bar

In the Designer Studio, use the buttons on the toolbar and tab bar to work with rules
and data instances in your PRPC system.

Toolbar Buttons and Functions

The specific tools and selection boxes that appear on the toolbar vary depending on
your role, the type of workspace, and the contents of the form and list area. The
toolbar contains only buttons both relevant to the open object and available to you. If
a button does not appear or is unavailable (gray), the corresponding function is not
available to you in the current context.

Figure B-1 describes all of the buttons that might appear.

Name Button Function

Availability Opens the Availability dialog to change the availability of the

rule. Select Yes, No/Draft Mode, Final, Blocked, or Withdrawn to

@

set the availability of the rule.

Check In This button appears if:

£

» The rule is located in a RuleSet that is
under rule management

» The rule is currently checked out to you.

After you check out a rule to work on it (in your private
RuleSet), use this Check In button to copy the modified rule
instance over the original one in the public RuleSet.

Check Out This button appears if:

v

» The rule is located in a RuleSet that is
under rule management

» Your Operator ID settings allow you to
check out rules

»  The rule is not currently checked out to
you.

Creates a copy of the rule in your private RuleSet and marks
the original rule as checked out (locked). No one else can check

out a rule while it is checked out.

Delete bl Deletes a rule or data instance.
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Name Button Function

Delete Check- . Deletes a checked-out rule from your personal RuleSet,

out —1: effectively cancelling the check out. The original instance is not
affected.

Draft On/Off : i7 Draft On| Click to toggle draft mode on or off. Elements of this flow rule

may reference activities, flow actions, or other objects not yet
defined.

Favorites

Help

Launch

Click to save a link to a rule to your My Favorites menu, or to
delegate a rule to another user or group of users.

Opens the help system at the help topic for the currently
displayed rule or data form.

Moves the current rule or data form into a separate, floating
browser window with a copy of its own toolbar. This action lets
you compare two forms, or work with some information or
values in the main portal window and paste them into another

portal window.

New

Preview

Creates a new rule or data instance of the same type as the
currently open rule or data instance. To create a new rule or
data instance of a different type, click the arrow to display a
menu to select another rule type.

Splits the workspace to present a partial preview of the runtime

appearance of a rule in the bottom half of the split workspace.

Private Check

For a privately checked-out rule in your personal RuleSet,

In 2 copies the modified instance over the original instance in the
public RuleSet. After you have performed a private check out,
this button appears if the conditions that allow the rule to be
checked in to its base RuleSet and version are present.

Private Check & /' Creates a copy of a rule in your personal RuleSet. This displays

Out

when you have the pxAllowPrivateCheckout privilege, the Allow
rule check out? checkbox in your operator ID form is selected,
the rule is not available for regular checkout, and the rule
belongs to a RuleSet that has the rule management facility
enabled.

Private check out is not possible for a few rule types, such as
class rules. Also, you cannot privately check out a rule that

belongs to an override RuleSet.

Reattach

Recover

After Launch only. Closes the launched window and consolidates
any open forms in the launched window with the main window.
Recovers the most recent version of a deleted rule, if the

RuleSet and version combination is unlocked.

Related Rules

Restore

A

Lists rules related to the current rule. Clicking displays a menu
that lists lower-numbered versions of the currently open rule,
circumstance and circumstance-date, editions, and additional
menu items.

Replaces the current checked-in copy of a rule with the last

checked-in copy of that rule.
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Name Button Function

Rule Data E Shows the XML document that makes up the form displaying
this instance. This is primarily a debugging tool.

Run L_H Starts execution or testing of the current rule, in the current
context.

Save E Saves the instance to the PegaRULES database.

Save As @ Saves the instance under a different name, RuleSet, or version.

Show Java ..{_ﬂ After a rule is saved, displays an approximation of the

generated Java to be created by this rule instance in a new
window. (You cannot alter this Java code.) This button is visible
to developers who hold the privilege @baseclass.ToolbarFull.
Available for activities, when rules, and stream rules, among

others.

Figure B-1. Workspace Toolbar Buttons

Tab Bar Button and Functions

The tab bar identifies currently open rule or data instances, the Instances list, and
other displays. Tabs appear between the Home icon # at the left and the Currently

-

Open , Refresh ™, and Close “+ icons. Click a tab to make it the front tab. For a
tab that represents a rule, hold the mouse pointer over the tab to see the type, full
rule key, RuleSet, and version information of that rule.

Figure B-2 describes the persistent tab bar buttons.

Name Button Function

Home ﬂ Click to return to the What's Happening display and your home

view of the portal

Currently Open Click to list all currently open rules or other displays in a drop-
down menu. Select from the menu to bring a specific form or

display to the front.

Refresh o Click to refresh the Designer Studio display and display the most
current data from the system. Any inputs you have entered but

not sent are lost.

Close g Click to close the currently open rule form or other display.

Figure B-2. Tab Bar Buttons
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Appendix C: Workstation Setup

This Appendix describes setting up your PRPC workstation and includes information
about:

» Temporary Internet file settings
» Downloaded program files
» Other security settings

» Performance tips and keyboard shortcuts

Internet Explorer Settings

PRPC works with Microsoft Internet Explorer Web browser version 7, 8, and 9 with
current Microsoft security patches installed. To use the Designer Studio you must use
Internet Explorer. The Case Worker and Case Manager portals also support Firefox 2+
and Safari. Internet Explorer is also known as IE or MSIE, and serves as a thin client
for both application developers and application users. All pop-up blockers (such as
those provided by Yahoo! or Google toolbars) must be disabled.

Several settings are important for best use of MSIE with PRPC. In many cases, these
may correspond to the settings you normally use for Local intranet or other Local Zone
processing.

For additional settings not needed by most Fast Start Guide readers, select Help >
Developer Help to open the PRPC help system, and search for the topics “How to set
up Internet Explorer 7” and “How to set up Internet Explorer 8.

Temporary Internet Files Settings

PRPC uses HTTP 1.1 and marks pages as expired as appropriate. To set this property
in Internet Explorer version 7 and version 8, navigate to Tools > Internet Options >
General and click the Settings button under Browsing history. Select Automatically
in the Temporary Internet Files options.

The system responds best if your MSIE cache is enabled, because the cache can store
images and other static files locally. However, caching is not required.

Downloaded Program Files

PRPC uses a few ActiveX controls on the workstation. Each automatically downloads on
demand (only as needed) if permitted by your Windows network account and browser
settings.

If your Windows account has Power User or Administrator privileges, you can
download these controls. If not, another user with appropriate privileges can download
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them for you, by signing on and using PRPC briefly. (You do not need Power User or
Administrator privileges to run the ActiveX controls.)

From the Windows Control Panel, double-click Internet Options, or from Internet
Explorer, select Tools > Internet Options. On the Security tab, select the Local
intranet zone to confirm that you can download signed ActiveX controls. You can set
security for the Local intranet zone to Low, or you can select Custom level and enable
the download settings (Figure C-1 and Figure C-2):

_5‘-3 Downloads
_3‘-3 Automatic prompting For file downloads
() Disable
(¥) Enable
_3‘-3 File download
() Disable
(¥) Enable

Figure C-1. Download Enabled

|#| Run Activel conbrols and plug-ins
() administrator approved
() Disable
(*) Enable
{:} Prompk

Figure C-2. ActiveX Downloads Enabled

Other Security Settings

Typically, the PRPC server operates on a local area network (LAN) and appears in the
Local internet zone of Windows Internet Properties and Internet Explorer Internet
Options. You can adjust security settings for the Local internet zone without affecting
the security settings you want to apply for the Internet zone. The default Local
internet zone security setting of Medium or Medium-Low is generally appropriate for
PRPC use. Some special cases requiring customization are noted here.

» Cookies — PRPC uses cookies. Confirm that your browser’s settings allow cookies.

» Pop-up windows — Certain portal operations use pop-up windows. Pop-up blockers
(such as the Google toolbar) may interfere with correct operation of these windows.

» Scripting — PRPC uses JavaScript. Applications based on PRPC may use VBScript or
JScript in addition to JavaScript. Users must have the ability to execute scripts in the
Local Zone. This is available under the Low setting for the Local intranet zone or as a
custom setting:

) Scripting
Ackive scripting
) Disable
)} Enahls
) Proenph
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Performance Tips and Keyboard Shortcuts

Designers, developers and users are most productive if they remember these tips:

Do not use the browser’s Back button or Back keyboard shortcut. Do not use the
browser’s History capabilities to return to an earlier page. The older pages may
contain stale information, and the browser’s Back and History features may interfere
with session synchronization.

¥
Click the Refresh button ““on the Designer Studio tab bar, not the Internet Explorer
Refresh button or the F5 key, to refresh the current display.

Press CTRL+F to search for text on a page.
Press CTRL+P to print the current page.

Click the Home Icon # at the left of the Designer Studio tab bar to return to the
Home display.
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Appendix D: Installing the ASupply
Application

This Appendix describes how to install the ASupply application. You can download the
the Fast_Start_62SP2.zip and import the ASupply application into PRPC.

The Fast_Start 62SP2.zip file contains two files:

m  ASupply V62SP2.jar — the application archive to import into PRPC

m Fast_Start Guide_62SP2.pdf — this guide to working with PRPC and the
ASupply application

Installing the ASupply Application

The following procedure describes how to import the ASupply application into your
PRPC system.

Depending upon the state of your database, PRPC windows may appear differently. To
install the ASupply application, browse to the location of the ASupply_V62SP2.jar file,
and then click Next throughout the Import wizard to accept the defaults.

1. Open the Fast_Start_62SP2.zip and save the files to your local directory.

2. Log into your PRPC system using an operator ID and password that has the
appropriate privileges to import rules (for example, privileges similar to those given
by the PegaRULES:SysAdm4 access role). The Designer Studio opens.

3. Inthe Designer Studio, select the Pega button ( @) and then click Application >
Import & Export > Import (Figure D-1).

PegaRULES ¥  Administrator ¥

Show All

Overview

» j » ning

Process & Rules 3 d Profile 3

Data Model 3 Structure 3

0 complete syste
Inventory » |may take a few
f this process, cl

User Interface 3

Reporting » Guardrails 3

Integration » Development 3

Package

Org & Security » Export

BT LR
&L REE

System » Tools 3

Figure D-1. Designer Studio Import
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4. Browse to the ASupply_V62SP2.jar file and then click Next (Figure D-2).

P

X, Import Wizard

= Select a local File to Load and Import

CAASupphy_WE25P2 jar

Click "MNext™ if you wish to import a file already loaded on the server.

Figure D-2. Browse to .jar file

5. Verify that ASupply_V62SP2.jar is selected and then click Next (Figure D-3).

O

lepoerizard

= Select a File From the Server to Import

»

ASupply_VE25P2 jar File Information

|, |

Creation-Date: 2013-Jan-24 10:31:48
Operator: Administrator
Mame: ASupply_VG25P_32212 jar

Show Content Details

I~ Enable advanced mode to provide more granular control over the import process.

Figure D-3. Click Next
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6. Click Next to update the database schema (Figure D-4).

Import Wizard File: ASupply_V625P2.jar Status: Open

= Schema
The bundle requires changes to the database schema.

In order for this application to work correctly, these schema changes must be applied.

® Automatic: PRPC applies the database schema changes using the database user pega2

" Manual: The database schema changes are applied manually by using the button below to download the SQL DDL script.

If you wish to execute the schema changes manually you cannot proceed further with the wizard

Download the SQL DDL, execute the schema and start the wizard again

Displaying 4 records
1

Class Table Has DB Schema Changes
3 ACORP-FW-ASupply-Waork pc_ACORP_FW_ASupply. Yes
% History-ACORP-Data-LineltemDetails pr_History_ACORP_Data_Li_e88ed Yes
s History-ACORP-Data-Order pr_History ACORP_Data_Order Yes

» History-ACORP-F

~ASUpply-Work pc_History ACORP_F

W

_ASupply_Wo Yes

Displaying 0 records

Selected Class View Has DB Schema Changes

Mo matching data was found.

! Cancel ) [ << Back ) € Hext>> )

Figure D-4. Update database schema

7. When the import to the database is complete, click Next (Figure D-5).

PRSI

Import Wizard File: ASupply_V625P2.jar Status: Open

Import complete to database from the file ASupply_VG2SP2 jar

100.00%

Time Left: 0 seconds

Total Records: 4 Records Moved: 4 Records Skipped: 0 Total Errors: 0

Currently Processing: ASupply_VE25P_32212_rules jar (2 of 2)

Figure D-5. Import to database
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8. Data is saved to the database. This may take a few moments. When this is
complete, click Done (Figure D-6).

[ PR

Importing ASupply_V62SP_32212_rules.jar from ASupply_V62SP2.jar

Import complete to database from the file ASupply_V62SP_32212_rules jar

100.00%

Time Left 0 seconds
Total Records: 132 Records Moved: 132 Records Skipped: 0 Total Errors: 0

Figure D-6. Import complete

9. Log-out of PRPC. The ASupply application is ready to use in the hands-on
exercise, beginning in Chapter 2 of this guide.
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Appendix E: Contacting Pegasystems
This appendix describes how to contact Pegasystems for:

» Education services
» Documentation feedback

For more information about our company and products, visit our Web site at
Www.pega.com.

Education Services

Pegasystems University of Pega offers a wide range of courses for our customers. For
course descriptions and contact information, go to
http://pega.com/services/university-of-pega/pega-education-services. University of
Pega offers both live classes and e-Learning courses. Courses can be presented at
customer sites also.

Documentation Feedback

Pegasystems strives to product high-quality documentation. If you have comments or
suggestions about this guide or about the sample ASupply application, send us an
email with the following information:

» Document name, version number, and date it was updated (located at the bottom of
the copyright page)

» Page number

» Brief description of the problem

Send the email to: mailto:docteam@pega.com.

Note: This email address is for providing feedback on this guide and sample application

only.
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